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Computer Level 1

1. My Computer

I. Answer the following questions.
1. Write any five uses of the computer.

1. We can read stories and poems on it.

2. We can send/receive emails to/from our friends.

3. We can play games on it.

4. It can play songs, movies and music for us

5. We can quickly solve our sums on it.

6. We can talk to anyone, anywhere in the world.

II. Tick the correct statement and cross (X) the wrong one.
1. right 2. wrong 3. wrong 4. wrong 5. right

III. Fill in the blanks using the words given in the help box.
1. Draw 2. Sums 3. Games 4. Stories 5. Emails

2. A Magical Machine
I. Answer the following questions.
1. Write the names of four natural things.

A. 1. Air 2. Water 3. Soil 4. Trees

2. Write the names of four man made things.

A. 1. car 2. table 3. pen 4. aeroplane

3. What is a Computer ?

A. Computer is an wonderful electronic machine with

special qualities and it runs on electricity

4. What is a machine ?

A. Machines are also man made things. They help us to do

our work easily.
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II. Spell and write.
MACHINE COMPUTER

II. Tick the correct answer.
1. a 2. b 3. c 4. a 5. a

II. Tick (�) the correct statement and cross (X) the wrong one.
1. right 2. Right 3. wrong 4. wrong 5. wrong

Activity zone:

I. See the pictures of some machines given below.

Complete their

1. Cooler 2.  Mobile 3. Television 4. Watch

II. Here are some of the machines that are used in our

house. Writetheir functions with the help of hints.

1. To listen to songs 2. To wash clothes

3. To iron clothes  4. To cook food

3. Parts of a Computer

I. Answer the following questions.

1. What is a Computer ?

A. Computer is an wonderful electronic machine with

special qualities and it runs on electricity

2. How many parts are there in a Computer ?

A. Computer has  many parts like monitor, keyboard,

mouse, CPU, Printer etc.

3. What is a mouse ? Explain briefly.

A. A mouse is a pointing device which controls the

movement of the cursor on the monitor screen. It is used

to select the object on the screen.
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4. Explain briefly about the CPU.

A. CPU stands for Central Processing Unit. It is called the

brain of the computer. All other components of computer

are connected to the CPU.

II. Fill in the blanks.

1. Television 2. Central Processing Unit

3. Mouse 4. Typewriter

III. Tick the correct answer.

1. b 2. b 3. a 4. c 5. b

IV. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. True 2. True 3. True 4. True 5. True

V. Re arrange the jumbled words.

1. KEYBOARD 4. MONITOR

2. MOUSE 5. SPEAKER

3. COMPUTER

Activity:

III. Identify each picture and write its first letter in the box

given.

COMPUTER

4. Keyboard and Mouse

I. Answer the following questions.

1. What is keyboard ?

A. Keyboard is an important part of the computer.We use

a keyboard to type on a computer.

2. What is the use of Numlockkey ?
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A. Numlock key is used to lock or unlock the number keys

from 0 to 9

3. What happens when Enter key is pressed?

A. Enter key is pressed to move the cursor to the beginning

of the next line.

4. What is mouse ?

A. A computer mouse is used to point and select things on

the monitor.

5. What is clicking ?

A. Pressing the mouse button is called clicking.

6. What is double click ?

A. Pressing the left mouse button twice without any gap is

called double click.

7. What is right click ?

A. Pressing the right mouse button to open alist of

commands for the selected object is called right click

II. Fill in the blanks.

1. Space bar key  2. Delete  3. Clicking

5. Start and Shutdown
I. Answer the following questions.

1. What is the first step to turn on a computer ?

A. Switch on the power button

2. What is the last step to turn off a computer ?

A. Switch off the power button

3. Which button do you press on the CPU to switch on the

computer ?
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A. We press the CPU power button

II. Fill in the blanks with the help of hints.

1. Desktop   2. Left 3. Icons 4. Power plug

5. Shutdown

III. Tick the correct statement and cross (X) the wrong one.

1. Wrong 2. Wrong 3. Right 4. Right 5. Right

Activity:

I. Arrange the steps in order to start a computer.

1. 4 2. 2 3. 3 4. 1

6. Lab Manners
I. Answer the following questions.
1. Write any four ways, how we should behave in a

computer lab.
Z Always walk in a queue, while entering the computer lab.
Z Keep the computer lab neat and clean.

Z Never touch the electric sockets. Take help of your teacher.
Z Always maintain silence while working or playing on a

computer.
Z Use the devices like keyboard and mouse very softly.

Z Do not click the mouse buttons unnecessarly.
Z Do not take eatables and drinks to the computer lab.

Z Always keep the mouse on a mouse pad.
II. Fill in the blanks.

1. Neat and clean 2. Shutdown 3. Shoes
4. Mouse pad 5. Shutdown

III. Write true (T) for a correct statement and false (F) for
an incorrect statement.
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1. true 2. false 3. True 4. False 5. false

6. false
IV. Re arrange the jumbled words.

1. COMPUTER
2. COVER

3. SHOES
4. KEYS

5. SILENCE
V. Tick the correct answer.

1. c 2. a 3. b 4. a
Activity:

I. Tick the correct action and cross (x) the wrong action.
1. Wrong 2. Wrong 3.  Right  4. Right

5. Right 6. Wrong

7. Human Beings and Computer
I. Answer the following questions.

1. What are the advantages of a computer ?

Z computer has a  very large memory

Z It does not get tired

Z It can work faster than human beings

2. Explain briefly about computers ?

A. Computer is a wonderful electronic machine made by

human beings.A computer works as per the commands

given by the human beings.

3. What are the limitations of a computer ?

Z A computer cannot do anything by itself.

Z A computer does not have intelligence
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Z A computer cannot explain reasons

II. Fill in the blanks

1. Does not get 2. No 3. Electronic

4. Wonderful 5. Intelligence 6. Reasons

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. True 2. false 3. False 4. true 5. false

IV. Match the following.

1. b 2. d 3. e 4. a 5. c

8. Fun with Paint

I. Answer the following questions.

1. What is the use of pencil tool in MS paint ?

A. Pencil tool is used to draw shapes and lines in MSpaint

2. Explain briefly about eraser.

A. Eraser tool is used to erase or remove what we have

drawn

3. What do you understand about shape tool?

A. The shape tool is used draw different shapes like

diamond, pentagon etc

4. What are the steps involved in drawing a circle.

Z Click the Oval tool in the Shapes group.

Z Click the left mouse button and press the Shift key.

Z Now, drag the mouse pointer while keeping the Shift

key pressed.

Z A circle will be drawn.
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5. Explain briefly about rectangle tool.

Z Click on the Home tab.

Z Click on the Rectangle tool Shapes group.

Z Move the mouse pointer to the drawing area.

Z The pointer changes into a'+' sign.

Z Hold down the left mouse button and drag the mouse to

draw a rectangle.

Z Release the mouse button when a rectangle is drawn.

6. Explain about fill with color tool.

A. Fill with color tool is used to fill color in an object.

7. Write about the brush tool ?

A. Brushtool is available under brush box with different

sizes which helps to color the object.

II. Fill in the blanks.

1. Fill with color tool 2. Pencil 3. line

4. Microsoft paint 5. Triangle

III. Tick the correct statement and cross (X) the wrong one.

1. right 2. right 3. right 4. wrong
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Computer Level 2

1. Computer - A Machine

I. Answer the following questions.

1. Mention any 5 things that you can do with a computer.

Z We can draw pictures

Z We can solve different types of problems (sums).

Z We can listen music

Z We can play games

Z We can watch films (movies).

2. Write about desktop computer.

A. It is also known as a Personal Computer (PC). It can be

placed on a desk or a table. Because of its big size, it

cannot be moved from one place to another place easily.

3. Write about Laptop.

A. Laptop computer can be easily carried from one place

to another. A laptop is a small computer that can be

placed on one's lap. It works on batteries so we can carry

it anywhere.

4. Write about Smartphone.

A. Smartphone  is mobile in nature, which can fit in our

pockets. It's size is smaller than tablets. It also plays the

role of computers.

II. Fill in the blanks.

1. Electronic 2. Mistakes 3. Personal computer

4. Laptop
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III. Tick the correct answer.

1. 1 2. 2 3. 3 4. 2 5. 1

IV. State True or False.

1. False 2. True 3. False 4. False 5. True

2. Computers and Me
I. Answer the following questions.

1. What is a computer ?

A. The computer is a very useful machine. We can do many

actvities using a computer.

2. What is the difference between a man and a computer ?

Man Computer

Cannot work as fast as a computer Works fast

Can make mistakes Does not make mistakes

Gets tired Does not get tired

3. What can a computer do ?

A. Computers can do calculations, share data,play music

and games.

4. What can a computer not do ?

A. Computers can not eat, can not swim, can not breathe

II. Fill in the blanks.

1. Computer 2. Human 3. Computer 4. Read & Write

5. Computer

III. Tick the correct answer.

1. c 2. b 3. d

IV. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. False 2. False 3. True 4. True 5. True
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V. Write (C) against the task that a computer can do better

and (M) that man can do in better manner.

1. C 2. C 3. M 4. C 5. M

3. Features of Computer

I. Answer the following questions.

1. What are the features of a computer ?

A. Accuracy, Speed, Diligence, Storage and Versatility are

the features of computer.

2. Write about accuracy.

A. Computer is a very reliable machine. It always gives us

correct results when correct instructions are given to it.

3. Why computer is a multi task machine ?

A. Computer is a Multitask Machine. It can do many things

at a time. It can play music or a movie while we are

typing a letter on it.

4. Explain about diligence of a computer.

A. A computer can work for hours without ever getting

tired or bored.

5. Write about storage capacity of a computer.

A. A Computer has a large Memory. It can store huge

amount of data in its Memory.

II. Fill in the blanks.

1. Large 2. Electronic 3. Tired 4. Fast 5. Computer

I. Tick the correct answer.

1. d 2. a 3. a 4. a 5. b
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II. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. True 2. True 3. True 4. False

4. Working of a Computer

I. Answer the following questions.

1. What is an IPO cycle?

A. The three steps involving Input, Process and Output of

a computer is known as IPO cycle.

II. Fill in the blanks with the hints given below.

1. IPO 2. Input 3. Output 4. Input

5. Storage 6. Processing

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. True 2. False 3. True 4. False 5. False

5. Computer Devices

I. Answer the following questions.

1. Write about computer devices.

A. A computer is made up of many parts. These parts can

be classified into four groups.  Input devices, Processing

device, Output devices and Storage devices

2. Write a few lines about monitor.

A. A monitor is a device that displays images on its screen.

After processing the input, the results are shown on the

monitor.

3. Write about keyboard and mouse.
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A. The keyboard is one of the most commonly used input

devices. It is used for typing letters and numbers. The

mouse is also an input device. It is also used for drawing

images.

4. Write about Scanner.

A. A scanner is used to convert text or an image to its

electronic representation, which can be viewed on the

monitor. These scanned images can be used in different

documents.

5. Why CPU is called the brain of the computer ?

A. It is the inside the CPU box. It controls all parts of the

computer. So it is the brain of the computer. It stores a

lot of information.

6. Write about output devices.

A. The devices through which we get the result or output

after processing are called Output devices.

7. What is the use of speakers ?

A. It helps you to hear sound or music that you have played

on the computer.

8. What is the use of a pendrive ?

A. A Pen drive is used to store information. It is also used

to transfer information from one computer to another.

It is also known as Flash drive.

9. Write about hard disk.

A. The hard disk is a Storage device. It is used for storing

information. It is fixed inside the system unit.
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II. Fill in the blanks.

1. Input 2.Output 3.Central Processing Unit 4. Digital

Versatile Disk 5.Storage Devices

III. Tick the correct answer

1. 2 2. 1 3. 2 4. 3 5. 2

IV. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. False 2. False 3. True 4. False 5.True

6. True 7. False

6. Uses of Computer

I. Answer the following questions.

1. Name some places where computers are used.

A. Computers are used at schools, homes, offices banks

and hospitals, shops etc.

2. Write any 5 uses of a computer.

Z Computers are used in schools to maintain records of

the students, teachers and fees.

Z In banks, computers are used to keep the details of all

the bank accounts.

Z Computers are used in the hospitals to keep the records

of the patients and generate bills.

Z A computer is used to keep record of the criminals.

Z Computers are used for tracking, scheduling, reporting

and monitoring railway and aero plane traffic.

3. What is the role of a computer in the field of designing ?
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A. A computer helps in designing clothes, cars, rockets,

aeroplanes and machines. It is also used by architects

to design houses.

4. What are the uses of computers in a hospital ?

A. Computers are used in the hospitals to keep the records

of the patients and generate bills.

5. For what purposes is computer used in hotels and

restarants ?

A. A computer is used to store information of the customers

and to generate bills.

6. What are the uses of computers in banks ?

In banks, computers are used to keep the details of all

the bank accounts. to provide ATM services and online

banking.

7. What are the uses of computers in railways & air ports ?

A. Computers are used for tracking, scheduling, reporting

and  monitoring railway and aero plane traffic. They

are also used to generate tickets

8. What are the uses of computers in schools ?

A. Computers are used in schools to maintain records of

the students, teachers and fees. They are used to teach

students.

II. Fill in the blanks.

1. Home 2. Hospital 3. Letters 4. Bills 5. Timetable

III. Tick  the correct answer.

1. b 2. b 3. a 4. b 5. b
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IV. Match the following.

1. Book tickets Railway station

2. Fee details schools

3. Generate bills shops

4. Bank accounts bank

5. Prepare/Generate medical reports hospitals

7. Keyboard

I. Answer the following questions.

1. What is keyboard ?

A. Keyboard is an important input device. It has many

buttons on it. The buttons on the keyboard are known

as keys. We can type letters and numbers by pressing

keys on the keyboard.

2. Why do we use the Backspace key ?

A. This key is used to erase anything typed on the left side

of the cursor.

3. What is the use of arrow keys ?

A. These keys are used for moving the cursor on the

monitor. They are marked with arrows in four different

directions.

4. What is the use of Numlockkey ?

A. This key is used to activate or deactivate the numeric

keypad.

5. What happens when Enter key is pressed ?

A. The Enter key is used to move the cursor to the

beginning of the next line.
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6. Write about five different types of keys.

A. The five different types of keys are

1. Alphabet Keys 2. Special Keys 3. Cursor Control Keys

4. Function Keys 5. Numeric Keys

II. Fill in the blanks.

1. Space bar key 2. Enter key 3. Delete

4. arrow 5.numlock

III. Tick the correct answer.

1. a 2. d 3. b 4. c 5. d

IV. Rearrange the following jumbled words.

1. Space bar 2. Shift key 3. Capslock

4. Arrow keys 5. Enterkey

V. Keyboard puzzle.

Z Shift Z caps Z delkey Z num

Z enter Z mouse Z scroll Z key

8.Mouse

I. Answer the following questions.

1. Write about mouse.

A. Mouse is an input device and has different actions. It is

a palm sized pointing device usually having one or more

buttons on the top.

2. What is mouse pointer?

A. As the user moves the mouse around on its pad, an arrow

head moves on the screen. This is called the Mouse

pointer.

3. What are the types of mouse?
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A. There are three types of mouse : Two button mouse,

Three button mouse and a scroll mouse.

4. What is clicking ?

A. Pressing the mouse button is called Clicking. To select

the pointed object we single click the left mouse button.

5. Write a few lines on double click.

A. To open or start the selected object we press the left

mouse button twice without any gap.

6. What is right click ?

A. To open a list of commands for the selected object we

press the right mouse button.

7. What is dragging ?

A. To move the selected object we hold the left mouse

button down and move it to the new location. This is

called dragging.

8. What is dropping ?

A. Releasing the mouse button after dragging is called

dropping.

II. Fill in the blanks.

1. Mouse 2. Mouse pointer      3.clicking

4. dropping      5.dragging

III. Choose the correct answer.

1. B 2. A 3. C 4. B 5. A

IV. Mouse puzzle.

Click Dropping Dragging Mouse Pad
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9. Notepad

I. Answer the following questions.

1. What is notepad ?

A. Notepad is a text editor that comes with Microsoft

Windows. You can type text and create very simple text

files using it.

2. Write the shortcut key to open a new document in

notepad.

A. Ctrl + O is the shortcut key to open a document in notepad.

3. What are the steps to exit notepad ?

A. To close the Notepad program, you can also click the

cross button on the right side of the window.

4. Write the steps to save a notepad file.

A. Select the Save As option from the File menu.

Z The Save as dialog box will appear.

Z Type the file name in the File Name box.

Z Click the Save button.

II. Fill in the blanks

1. file 2. new 3. close 4. save 5. save as

III. Match the following.

1. 4 2. 5 3. 1 4. 3 5. 2

IV. Tick the correct option.

1. A 2. B 3. C 4. C

V. Write T for True or F for False.

1. False 2. False    3. False 4. True
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Activity zone

1. Write the shortcut keys for the following.

1. Ctrl + O 2. Ctrl + S 3. Ctrl + S 4. Ctrl + N

II. Number the steps in the correct order to open Notepad.

1. 2 2. 3 3. 4 4. 1

10. Introduction to Tux Paint

I. Answer the following questions.

1. Write any two features of Tux Paint.

A. It is a freely available application which is very easy to

use. The sound effects and an interesting cartoon

character (Penguin)

2. Write about shapes tool in Tux paint.

A. Shapes tool is used to draw different shapes like circle,

square, triangle, etc.

3. What is the white blank area for drawing called ?

A. The white blank area for drawing in tuxpaint is called

drawing canvas.

4. Write about lines tool.

A. Lines tool helps us to draw straight lines.

II. Fill in the blanks

1. Eraser 2. Quit 3. Paint 4. Tux Paint

III. Tick  the correct icon of Tux Paint. Number : 4
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Computer Level 3

1. History of Computers
I. Answer the following questions.

1. Write a few lines on Abacus.

Abacus was the first calculating device. Simple

calculations like addition and subtraction could be easily

performed using abacus.

2. Explain briefly about Pascaline.

In 1642, Blaise Pascal invented a calculating machine

and called it Pascaline. It consisted of a rectangular box

with eight movable wheels which could calculate upto

eight figures.

3. Write about Napier Bones.

In 1616, Sir John Napier invented a calculating device

which was made up of rectangular rods. It was called

Napier's bones and could do calculations such as

addition, subtraction, multiplication and division.

4. Write a short note on ENIAC and UNIVAC.

ENIAC stands for Electronic Numeric Integrator And

Computer. It was the first general purpose electronic

computer. UNIVAC I, stands for Universal Automatic

Computer, which was also designed by J Presper Eckert

and John Mauchly. It was the first commercial electronic

computer.

5. What do you understand by the Difference Engine ?

In the 19th century, Charles Babbage invented the first

mechanical computer. It was called the Difference
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Engine. It was designedto calculate polynomial

functions.

6. Write about the first generation of computers.

The first generation computers are characterised by the

use of vacuum tubes. Characteristics:

Z Used magnetic drums

Z Heavy and large in size

Z Very expensive

Example : ENIAC, EDSAC, UNIVAC I, UNIVAC II

7. Write about the fourth generations of computers.

The fourth generation computer used microprocessors.

Characteristics

Z Thousands of integrated circuits on a single chip

Z Smaller in size

Z Cheaper and faster

Z Very easy to handle

Z Laptops and hand-held devices were invented

Example : IBM System 4300, ICE 2900

8. Describe about the fifth generation of computers ?

The fifth generation computers were based on artificial

intelligence. This generation is still in development.

Characteristics

Z High speed logic and memory chips

Z High performance

Z Intelligent and has ability to take decisions on its own

Example : Robots
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II. Fill in the blanks.

1. Abacus 2. Sir john napier

3. Pascaline 4. Difference engine

5. Integrated circuit 6. Universal automatic Computer

7. Third generation

III. Tick  the correct answer.

1. c 2.b 3.c 4.c 5.c

IV. Match the following.

1. B 2.E 3.D 4.C 5.A

2. Computer - A Smart machine
I. Answer the following questions.

1. What is an electronic machine ?

An Electronic Machine is a machine in which the

electronic components like transistors and IC's are used.

A Television, VCR, Tape Recorder, Calculator and

Computer are the electronic machines.

2. What is an IPO cycle ?

A computer is a machine that works on the principle of

IPO (lnput - Process - Output)

3. Write about working of a computer.

Computer works on the principle of IPO. (Input

processing  and Output.)

4. Why computer is a smart Machine ?

This smart machine processes the data that we enter

and gives us desired results according to the instructions

given by us. A computer is a smart machine that helps

us to do various things.
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5. Write about Microcomputers.

Microcomputers are the most commonly used

computers.

Z They are very small in size.

Z They are also known as personal computers (PCs).

Z They are used in places like schools, offices, shops and

homes.

6. What are the limitations of computers ?

A computer has many limitations.

Z It does not have feelings. It never feels happy or bored

or tired.

Z It cannot take decisions on Its own. It works as per the

given instructions.

Z It cannot think. It works on the set of instructions

provided to it.

7. Write about features of a computer.

Computers has many features such as speed, accuracy,

memory, diligence, versatility, and reliability.

II. Fill in the blanks.

1. Input 2. IPO 3. Input process output

4. Hard disk 5. Super computers6. Mini computers

7. Mainframe

III. Rearrange the following jumbled words.

1. COMPUTER 2. PROCESSING

3. INPUT 4. OUTPUT
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IV. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. false 2. false 3. true 4. true 5. true

V. Match the following pictures with their correct group.

Monitor-output device

Keyboard&mouse -input device

CPU-processing device

3. Computer - Buttons, Sockets and Slots

I. Answer the following questions.

1. Write about the USB ports on the computer case ?

A. Most desktop computers have several USB ports. These

can be used to connect almost any type of device,

including mouse, keyboards, printers, digital cameras

and more. They will often appear on the front and

backside of the computer.

2. Where will you connect your computer monitor cable ?

A. The common port is VGA, used for connecting your

standard monitor (screen).

3. Write about the audio ports on the computer case ?

A. Almost every computer has two or more audio ports

where you can connect various devices, including

speakers, microphones, headsets, and more. For analog

audio, the blue (line input), green (speaker / headphone)

and pink (microphone) jack interface are found on every

computer.
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4. Write about the ethernet ports on the computer case ?

A. This port looks a lot like the modem or telephone port

but it is a little bit wider. You can use this port for

networking and also connecting to the internet.

5. Write about the expansion slots on the computer case ?

A. These empty slots are where expansion cards are added to

computers. For example, if your computer does not come

with a video card, you can purchase one and install it here.

6. Write a short note on the Audio in / Audio out port

A. Many computers include audio ports on the front of the

computer case that allow you to easily connect speakers,

microphones and headsets, without fumbling with the

backside of the computer.

II. Read the clues below to match each word to its meaning.

Fill in the blank with the correct answer from the box.

1. Optical Disk Drive 2. Ethernet port

3. Serial port 4. PS/2

III. Tick the correct answer

1. A 2. D 3. A 4. B 5. C

II. State True or False

1. T 2. F 3. T 4. T 5. F

4. Keyboard and Mouse

I. Answer the following questions.

1. Why do we use delete key ?

A. This key deletes the character or shifts characters to the

right of the cursor. This key is present above the arrow keys.
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2. Why do we use backspace key ?

A. It is used for erasing any letter written on the left side

of the cursor.

3. What is the use of arrow keys ?

A. There are four keys with arrows marked on them in four

directions i.e., right left, up and down. These keys can

be used to move the cursor up, down, left or right on

the screen.

4. What is the use of numlockkey ?

A. When the num lock is 'on' these keys are used to enter

numbers.

5. Write about combinational keys ?

A. The Combinational Keys are also known as Command

Keys. They can be used only in combination with some

other keys. The 3 most common are the Control or Ctrl,

Alternate or Alt and the Shift keys

6. Give a short note on Caps Lock key ?

A. When the Caps Lock is ON, you will get capital letters.

7. Write about types of mouse?

Z Mechanical mouse

Z Optical mouse

Z Wireless mouse

Z Touchpad mouse

8. What are the parts of the mouse ?

A. A mouse has the following parts.

Z Left button
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Z Right button

Z A scroll-wheel between the two buttons

Z A tail-like wire connected to the CPU

9. Explain how to hold a mouse ?

A. We place our right-hand on a mouse. The index finger

is placed on the left button and the middle finger on the

right button. The scroll-wheel is between the two fingers.

10. What is dragging and droping of a mouse ?

A. Moving a mouse while keeping the left button pressed

is called dragging. We use dragging to move an item

from one place to another on the screen. Releasing the

mouse button after dragging is called dropping.

11. Write the steps to select an item by using mouse ?

A. Step 1 : Move the mouse pointer to a document on the

screen and then click it once. Its colour will change. It

shows that the document is now selected.

Step 2 : Now click the left mouse button twice on the

selected document to open it.

12. What is Mouse pad ?

A. A mouse pad is a clean and smooth mat used underneath

a mouse. It helps the mouse to move smoothly.

II. Fill in the blanks.

1. Spacebar key 5. Input 9. Dropping

2. Backspace 6. Touchpad 10. Wireless

3. Arrow 7. Mousepad

4. Nums lock 8. Open
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III. Tick the correct answer

1. A 2. C 3.C 4. B 5. A

6. B 7. A 8. C 9. B

IV. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. F 3. T

III. Rearrange the following jumbled words.

1. SPACEBAR 4. ARROWKEYS

2. SHIFTKEY 5. ENTERKEY

3. CAPSLOCK 6. CLICK

5. Tuxpaint

I. Answer the following questions.

1. What is the use of Tux Paint ?

A. Tux Paint is drawing software which is specially

designed for the children to explore their creative skills.

Its variety of readymade tools helps children to make

wonderful drawings.

2. Name the various components of Tux Paint screen.

Z Title bar

Z Selectors

Z Toolbar

Z Color palette

Z Drawing area

Z Help area

3. What is the use of selectors in Tux Paint ?
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A. These are on the right side which gives more options

about the tool selected in the toolbar, like if Paint (Brush)

tool is selected, it shows the various brushes available

to choose from.

4. How can you save your drawing in Tux Paint ?

A. Click save button in the tool bar to save your drawing

which can be opened any time when needed.

II. Fill in the blanks.

1. Drawing canvas 4. Full screen, windowed

2. Eraser 5. Picture

III. Choose the correct answer.

1. B 2. C 3.A 4.B 5. B

II. Match the following.

1. C 2. E 3.A 4.B 5. E

6. More on Tuxpaint

I. Answer the following questions.

1. What is the use of Magic tool in Tux Paint ?

A. Magic tool offers a set of many special tools which helps

to draw with amazing effect.

2. Name any two types of Magic tools available in the

Tux Paint.

A. Bricks tool, Blur tool, Flowers and gross tool

3. How text tool is useful for us ?

A. If you want to write some message on your drawing,

you can make use of the Text tool.

4. How do you run the slide show of your Tux Paint drawings ?
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Z Click the open button in the toolbar.

Z Now will see all your saved drawing as thumbnails.

Z Now, click on the Slides button in it, to convert your

drawings into slides.

Z Click the thumbnails in the order, you want to play them.

Z The slide number will appear at their lower right corner.

Z Use Slope Bar to set the time duration of each slide.

Z Click the Play button to start the show.

II. Fill in the blanks.

1. Effects in the drawing 4. Rubber stamps

2. Magic wand 5. Text tool

3. Fill tool

III. Choose the correct answer.

1. B 2. A 3.B 4.A 5. D

IV. Match the following.

1. B 2. A 3.E 4.C 5. D

7. Introduction to MS paint

I. Answer the following questions.

1. What are the steps undertaken to open MS-paint program.

A. Follow the steps to load MS paint

Z Click the Start menu.

Z Click All programs

Z Choose Accessories

Z Click on MS - Paint option.

2. What are the features of MS-paint ?
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Z We can create, edit and paint pictures.

Z We can draw the different shapes easily and fill them

with colors.

Z We can view and edit the pictures.

Z We can save pictures in different file formats (.png, jpeg,

tiff etc.).

3. What is Ribbon?

A. The Ribbon is a graphical control element, which

contains the tools used in the application in the form of

buttons. The Ribbon contains various groups of tools

and commands. It is placed just below the Title bar.

4. Write about the steps followed to open an existing image.

A. Step 1: Click the Paint button.

Step 2: Select Open option. The Open window will be

shown with all existing images.

Step 3: Select an image. It will be opened in the Paint

window.

5. Mention the steps to create a new drawing ?

A. The New option is used to create blank drawing area.

Steps to create a new drawing

Step 1: Click on Paint button.

Step 2: Select the New option from the menu. A new

blank drawing area appears with different dimensions

6. Explain in detail how to save a drawing ?

A. Steps to save a Drawing:

Step 1: Click on the Paint button.
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Step 2: Choose Save as option. The Save as dialog

appears,

Step 3: Choose the location, where you want to save

your image,

Step 4: Type the names of the images and choose the

file format.

Step 5: Click on save button. The drawing will be saved

with the given name at the selected location.

7. Explain in brief how to close paint ?

A. To close the MS-Paint

Step 1: Click on Paint button. Step 2: Select the Exit

option. If you have not saved the changes. Paint displays

a dialog box to save the changes.

II. Fill in the blanks.

1. MS Paint 4. Drawing area

2. Redo and save 5. Ribbon

3. Title bar

I. Choose the correct answer.

1. B 2. A 3.A 4.A 5. C

II. Match the following.

1. B 2. E 3.A 4.D 5. C

8. Drawing in MS paint

I. Answer the following questions.

1. What is the use of pencil tool in MS paint
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A. Pencil tool is used to make freehand drawings. It is also

used to draw thin, free form lines or curves.

2. Explain briefly about eraser.

A. Erase tool is used to erase unwanted parts of the picture.

Use the Eraser tool to erase unwanted areas in the picture

3. What do you understand about shape tool ?

A. The 'Shapes' tool is used to draw different shapes while

drawing pictures the different shapes are: Line Shape,

Diamond Shape, Curve Shape, Pentagon Shape, Oval

Shape, Hexagon Shape, Rectangle Shape, Rounded

Shape, Polygon Shape,

4. What are the steps involved in drawing a circle.

Z Click the Oval tool in the Shapes tool.

Z Select a colour from the Colors group for the circle or

ellipse outline.

Z To fill the shape, select the Fill with color tool.

Z To draw an ellipse, drag the mouse pointer diagonally.

Z To draw a perfect circle, press and hold down the Shift

key while dragging the mouse pointer.

5. Explain briefly about curve tool.

A. Step 1: Click the Curve tool in the Shapes group.

Step 2: To choose the width of the curve, click the Size

drop-down button.
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Step 3: To choose the colour of the curve, select a colour

from the Colors group. Draw a straight line by dragging

the mouse pointer.

Step 4: Click where you want an arc of the curve to be

and then drag the mouse pointer to adjust the curve.

6. Explain briefly about rectangle tool.

A. You can draw a rectangle or a square using the rectangle

tool. Click the rectangle tool in the Shapes group to

draw a rectangle or square and rounded rectangle tool

to create a round-cornered shape.

7. Explain about fill with color tool.

A. Fill with color tool is used to fill colors in the drawing.

Steps to fill the color in drawings:

Step 1: Click on Fill with color tool.

Step 2: Choose the required color from the colors group.

8. What is magnifier tool?

A. The Magnifier tool is used to magnify or zoom a part of

a picture. Before using this tool you should open any

existing image on the drawing,

9. Write about brush & text tool?

A. Brushes are used to draw lines and paint with freehand.

There are 9 types of brushes that can be used to draw

different styles and textures.
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II. Fill in the blanks.

1. Pencil 4. Eraser

2. Fill with colour 5. Line

3. Text

III. Choose the correct answer.

1. D 2. C 3.A 4.A 5. D

IV. Write true or false.

1. T 2. T 3.T 4. F 5.T

9. Word Pad

I. Answer the following questions.

1. What is the use of WordPad application ?

A. WordPad is application software which we use for

writing poems stories and letters, etc.

2. Name three special effects used in WordPad.

A. There are three special effects, used for highlighting

the text. These are in the Home tab.

Bold : To add weight to the text

Italic : To give slanting effect.

Underline : To draw line under the text.

3. How do you create lists in WordPad document ?

A. Start Word, and then open your document. On the

Format menu, click Bullets and Numbering, and then

click the Bulleted tab.
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4. Write the steps to close WordPad ?

A. To close WordPad after completing your work. Click

Exit option in the WordPad tab or press close button on

the right corner of WordPad window. You can also press

Alt + F4 to close WordPad.

II. Fill in the blanks.

1. Start, All programs, Accessories, WordPad

2. WordPad, save as, filename, save

I. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. T 3.F 4. T

II. Choose the correct answer

1. B 2. A 3. A
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Computer level 4

1. Computer Memory

I. Answer the following questions.

1. What is memory ?

A. Computers consist of many components in which

information is stored and manipulated. These

components are called memory.

2. Into how many parts is a computer memory divided ?

A. Computers have more than one form of memory. We

can generally classify them into primary and secondary

memory.

3. Differentiate between Harddisk and External Harddisk.

A. Hard disk is a storage device that is used for storing. It

can store a very large number, which can range from

500 GB to 5TB. This Harddisk also contains the system

files to spiring life to the computer.External harddisk is

a type of harddisk which is connected to the computer

by a USB cable or other means. The capacity of this

harddisk is between 40 GB to 5 TB.

4. Write about PenDrive.

A. This is an electronic storage device and is popularly

known as Pen Drive. It is a plug and play device and

can be easily connected to the system through USB

(Universal Serial Bus) port.

5. Differentiate between DVD and CD.
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A. It is a thin plastic disc coated with reflective metal. Data

in these discs is stored optically. Its storage capacity is

up to 700 MB.These are also the optical storage devices

like CDs but their storage capacity is very high. A single

layered DVD can store up to 4.7 GB of data.

6. Explain about Blueray Disk.

A. This is a new invention in the field of optical storage

devices. Its storage capacity can range from 25 GB to

50 GB. These are also scratch resistant discs and can

safely store the data for a long time.

7. What is Volatile and non-volatile ?

A. RAM information stored in it is lost as soon as we switch

OFF the power supply. That's why it is also called

Volatile Memory. ROM holds these instructions even

after the power supply is switched OFF. That's why it is

also called Non-volatile Memory

II. Fill in the blanks.

1. Random Access memory

2. Read only Memory

3. Hard disk

4. Blue ray disk

5. USB flash drive

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. F 2. T 3. T 4. F 5. F
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IV. Match the following.

1. d 2.c 3.e 4.b 5.a

I. Identify the following devices and write their names.

1. Pendrive 2. Memory card 3. harddisk

4. blueray disk

2. Operating system

I. Answer the following questions.

1. Write a few lines on Operating system?

A. An operating system organizes the flow of data to and

from the CPU. Once the computer is switched on, the

operating system manages software and hardware of

the computer.

2. Name and explain the different types of the Operating

Systems?

A. Single-User Operating System : It allows only one

person to work and operate the system at a time. An

example of single-user operating system is DOS (Disk

Operating System). Multi-User Operating System: It

allows two or more users to use the computer resources

at the same time. WINDOWS and LINUX are two

examples of multiuser operating systems.

3. Write any four functions of the Operating System.

Z It recognizes the instructions through the input units

such as keyboard and mouse etc.

Z It sends the output to the monitor and printer etc.
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Z It allows loading the program such as MS word, MS

Excel, Movies etc. to run.

Z Managing the computer resources such as Input/Output

devices, CPU time and memory space.

Z File Management

4. Define the term OS.

A. An operating system (OS) is the most important software

that runs on a computer. To use a computer, an operating

system is essential.

5. Define the full form of CUI & GUI and give two

examples each.

A. CUI: Character user interface ex:MS DOS ,word star

GUI: Graphical user interface ex: windows and linux

6. Write about Windows.

A. The Windows is an operating system which offers many

facilities. Windows have been designed by a company

called Microsoft Corporation. Hence it is known as MS

Windows.

7. Write about shutting down windows.

A. 'Turn off computer' is used to shut down the computer.

Follow these steps to shut down computer.

Z Click the Start Button.

Z Click on shutdown button.

Z Your computer will be turned off.

II. Fill in the blanks.

1. Character user interface 2. MS-DOS

CYBERWAVE 47 Computer Level - 4



3. Windows 4.windows 10 5.Start button

III. Choose the correct answer

1. C 2.A 3.B

3. Working with windows 7

I. Answer the following questions.

1. Write about Microsoft windows?

A. Microsoft Windows is the most common operating

system being used worldwide today. It is called a

Graphical User Interface (GUI).We can perform

different actions on it by just clicking the mouse buttons.

There are many versions of Windows such as Windows

XP, Vista, Windows 7, Windows 8 and windows 10

2. What is Desktop?

A. It is the first screen that appears once the windows is

loaded in computers memory.When we click on our

user-Id and enter our password, we see the main screen

of Windows, called Desktop.

3. Write in steps how to change wallpaper and screensaver?

A. The various steps to change wallpaper are listed below.

Z Right click in the blank area of the desktop and choose

Z Personalize option in shortcut menu.

Z Click Desktop Background option in the personalization

window.

Z Select the picture from the built in gallery or click
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Z Browse button to choose your new wallpaper. Double

click the picture to set it as your desktop wallpaper.

The various steps to change a screen saver are listed

below.

Z Right click in the blank area on desktop and click

Personalize option to open the dialog box as shown.

Z Click Screen Saver option in this window to open Screen

Saver Settings dialog box as shown in figure.

Z Choose a Screen Saver from the drop list and set its

Wait time which will be the system idle time.

Z Click OK button to activate the Screen Saver.

4. Write the steps to select an icon.

A. We follow these simple steps to select an icon.

Step 1: First bring the mouse pointer to the icon.

Step 2: Then press the left mouse button to select it.

5. What is the use of Start button?

A. The start button is located on the left side of the taskbar.

This is the button that we use to start most of the

programs in windows.

6. What are the components of application window?

Z Titlebar

Z Control buttons

Z Taskbar

Z Menu bar

Z Workarea
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II. Fill in the blanks.

1. Operating system 2. Taskbar 3. Window

4. Filename and location 5. Taskbar

III. Choose the correct option.

1.b 2.b 3.a 4.a 5.a

IV. State True or False.

1.F 2.T 3.F 4.F 5.F

Activity:

I. Identify the given pictures and write names under the

space provided.

1. Computer 2. Internet explorer

3. Recycle bin 4. Documents

II. Solve the crossword puzzle with the help of clues given.

1. Windows 3. Disk drive  5. Taskbar

2. Icons 4. Computer

4. Windows Accessories
I. Answer the following questions.

1. Write the steps to start accessories ?

A. We can start any accessory program from the Start menu

by choosing the following options.

Start → All Programs → Accessories

2. Write about Notepad and Wordpad ?

A. Notepad is a utility to create text files which a generally

required for entering programs in various computer

languages. No formatting features such as bullets,

alignments etc. are available in the Notepad
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3. Explain in brief about Paint ?

A. A simple software called Paint is provided in windows

operating system for creating, drawing pictures. Several

drawing tools are provided to make painting an easy task.

4. What do you know about sticky note ?

A. Sticky notes can be used to write a to-do-list, a reminder

or anything else you want to write using pad of paper

5. What is snipping tool?

A. This tool can be used to capture a screenshot appearing

on your monitor screen and then annotate, save or share

the image.

6. Explain in steps how to add Gadgets on Desktop?

A. To add a gadget on the desktop

Z Right click in the blank area of the desktop and choose

Gadgets option in the shortcut menu.

Z A Gadget gallery will appear.

Z Double click the required gadget. Or right click on it

and choose Add option in shortcut menu.

Z The selected gadget will appear on the desktop, drag

and place it at the suitable location.

Z Close the gadget gallery.

7. Explain in steps how to remove Gadgets on Desktop ?

A. To remove the gadget from the desktop:

Move the mouse pointer over the gadget and click Close

button which appear besides the gadget. Alternatively,

you can also right click on the gadget and choose Close

gadget option in the shortcut menu.
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II. Fill in the blanks.

1. Accessories 4. Standard

2. Sticky notes 5. WordPad

3. MS paint

Brainteaser

I. Tick the correct answer

1. C 2. A 3. B 4. C 5. D

I. Match the following

1. E 2. A 3. C 4. B 5. D

ACTIVITY BASED LEARNING

I. Name the following gadgets.

1. Calendar 3. Cpu metre

2. Clock 4. Puzzle

II. Write the steps to open below Accessories from the start

menu.

1. Start → All Programs → Accessories → Word pad

2. Start → All Programs → Accessories → Calculator

3. Start → All Programs → Accessories → MS paint

4. Start → All Programs → Accessories → Sticky notes

5. Introduction to Windows 10
I. Answer the following questions.

1. Define operating system.

A. The software that controls the overall activities of the

computer is known as Operating System (OS). Windows

is the most widely used operating system.
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2. What is cortana ?

A. Cortana is one of the new features found in Windows

10 operating system. Cortana is designed to help the

users to find files, to search information on internet, to

set reminders and much more.

3. Write the steps to change the wall paper.

A. To change your desktop background, follow the steps:

Step 1 : Right-click on the desktop.

Step 2 : Select the Personalize option. Personalization

window appears.

Step 3 : Click on the drop-down arrow of Background

list box and select any option (Picture, Solid color,

Slideshow) from the list.

Step 4 : Select any picture from the Choose Your Picture

section or click on Browse button to get more options

of picture from the computer.

Step 5 : Click on the drop-down arrow of Choose a fit

list box. The selected picture will be set as desktop

background.

To change a Screensaver, follow the steps:

Step 1 : Right-click on the desktop.

Step 2 : Click on the Personalize option from the

displayed list. The  'Personalization' window will appear.

Step 3 : Select the Lock screen option from the left pane.

Scroll down and select Screen Saver Settings. The

'Screen Saver Settings' dialog box appears.
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Step 4 : Click on the drop-down arrow of Screen saver

section and select the Screen saver of your choice. Set

the time limit as per your need.

Step 5 : Click on the OK button.
4. What is screen saver?
A. When a computer is left idle for a certain period of time,

an image pops up on the computer screen. This image
is called Screen Saver.

5. Write in three steps, how to shut down a computer.
A. Activate the Start Menu by clicking on the start button

found on the bottom left corner of the screen. Now, Click
the Power button. A popup menu appears with three
options. Sleep,  Shut down and Restart Shutting down
computers saves energy Click on Shut down option to
shut down the computer.

II. Fill in the blanks.
1. Desktop 2. Icons 3. Recyclebin
4. Taskbar 5. Tiles

III. Match the following.
1. c 2. e 3. a 4. b 5. d

6. File explorer in windows 10

I. Answer the following questions.

1. What is File Explorer ?

A. File Explorer is a graphical file management utility for

windows 10 operating system. File management system

allows users to conveniently work with files / folders.

2. Name the tabs available in File Explorer Ribbon.
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A. The File Explorer Ribbon has four tabs namely File,

Home, Share and View.

3. What is the use of Search Box in File Explorer ?

A. It allows the user to search for files / folders. It displays

only those files that match what was typed in the search

box.

4. Write about the Content View in File Explorer.

A. Content view displays the list of files/folders in two

columns. The first column displays the file/folder name,

type and the second column displays information like

date modified and files size.

5. Write the steps to search for a file / folder

A. Open File Explorer, click on the Search box present at

the right corner of the window.The search tab appears,

now type a file/folder name or a part of file/folder name

to be searched Click the search button ( ) or press enter

key.The matching files/folders will be listed.

II. Fill in the blanks.

1. File explorer 6. Extra large

2. Addres bar 7. View

3. Recent files 8. CTRL+SHIFT+7

4. Four 9. Windows search box

5. Home 10. Title bar

III. Choose the correct answer.

1. b 2. d 3. c 4. c 5. c
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IV. Match the following.

1. c 2. d 3. e 4. 1 5. 2

V. Rearrange the jumbled words.

1. Frequent folder

2. windows search box

3. content view

4. explorer

5. location

VI. Give the keyboard shortcut for the following.

1. To Open Explorer Window : Win+E

2. To Refresh Explorer : F5

3. To select Search box : CTRL+F

4. To undo an action : CTRL+Z

5. To redo an action : CTRL+Y

7. Filesand folders in windows 10

I. Answer the following questions.

1. Write the steps to create a folder using mouse.

A. Creating A Folder Using Mouse Right Click the mouse

on a blank area within the File Explorer window, a

popup menu appears with a list of options. Click New ?

Folder option Thus, a new folder will be created with

the name "New Folder"at the desired location.

2. How will you open a file / folder ?

A. The Open option is used to view the content of a file /

folder. There are three different ways to open a file /

folder.
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Z Select the desired folder to open. Click the Open button

from the Home Tab

Z Double click on the folder

Z Place the mouse on the folder and then Right Click and

select the Open option from the popup menu.

3. How will you move a file/ folder ?

A. To move a file / folder follow the steps given below:

Z Select the file / folder.

Z Click on the Cut button from the Home Tab.

Z Select the location where the file has to be placed.

Z Click Paste button from the Home Tab

4. Write the steps to restore a deleted file/folder.

Z Open the recycle bin icon from the desktop

Z Select the file / folder to be restored.

Z Click Restore the selected items button to restore the

selected file / folder or click Restore all items button to

restore all the deleted files / folders.

5. How will you copy a file/folder ?

A. Select the file / folder.Click on the Copy button from

the Home Tab. Select the location where the file has to

be placed. Click Paste button from the Home Tab

II. Fill in the blanks.

1. Folder 2. Ctrl + Shift + N 3. Open

4. Rename 5. Recycle bin

III. Match the following.

1. b 2. d 3. e 4. c 5. a
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IV. Choose the correct the answer.

1. B 2. A 3. C 4. A 5. D

V. Rearrange the jumbled letters.

1. Restore 2. Location 3. Recycle

4. Destinaton 5. Shortcut

VI. State True or False.

1.false 2.true 3.true

4.false 5.true

I. Identify the given pictures and write names under the

space provided.

1. Powerpoint 2. Excel file 3. Recycle bin

4. computer 5. pdf file 6. word file

7. mp3 8. folder

8. MSW Logo

I.  Answer the following questions.

1. What is logo?

A. It is simple computer language. It was developed by

Seymour PapertWalleyFeurzeig, Cynthia Solomon at

MIT USA in 1967.

2. What are the components of logo ?

Z Graphic screen window

Z Commander window

3. Write a few lines on graphic screen window?

A. The graphic screen window is the place where output is

shown. There is a small triangle on the screen. It is called

turtle.
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4. Write about commander window.

A. It is the small area below the graphic screen window.

We can type commands here. It is divided into three

parts.

Z Command input box

Z Control buttons

Z Recall list box

5. Explain about primitives ?

A. The commands in logo are known as

premitives.Theytells the turtle how to move. The turtle

obeys the premitives,when we press the enter key

6. Write in steps how to exit MSW logo ?

A. Type 'Bye' in the input box and press the enter key on

execute button. On the menu bar click on file. A list of

options will be displayed. Click on exit to exit MSW

LOGO

7. What is turtle ?

A. Turtle is the main feature of logo. It is an on screen

cursor, that moves with commands entered by the

programmer or user. It is by no means looks like a real

turtle, but it resembles a triangle.

II. Fill in the blanks.

1. Execute 4. Status

2. Pause 5. Programme

3. Edall 6. Trimitives

7. Graphic screen window, commander window.
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III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. F 3.T 4. T

II. Match the following

1. B 2. A 3.C 4.E 5. D

9. Logo commands
I. Answer the following questions.

1. How does the RIGHT command works ?
A. This command helps the turtle to turn towards its right

by the degree of the angle specified. The syntax of
RIGHT command is : RIGHT [number of turn] or RT

[number of turn].
2. What are the differences between CLEARSCREEN and

CLEARTEXT commands ?
A. This command is used to clear the drawing on the main

screen;the short form for CLEARSCREEN is CS. This
command is used to clear the text appearing in the recall

list box. The short form for CLEARTEXT is CT.
3. What is the use of Home Command ?

A. This command will bring the turtle to the Centre of the
screen with the head pointing upwards.

4. Write the syntax of FORWARD and BACKWARD
commands.

A. The syntax of forward command is : FORWARD
[number of steps] or FD [number of steps]. The syntax

of backward command is : BACKWARD [number of

steps] or BK [number of steps].
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5. Write the syntax of the RIGHT and LEFT commands.

A. The syntax of LEFT command is : LEFT [number of

turn] or LT [number of turn].The syntax of RIGHT

command is : RIGHT [number of turn] or RT [numberof

turn].

6. What is the purpose of PD command ?

A. This command instructs the turtle to put the pen down

on the screen and continue drawing

7. What is the difference between HT and ST command ?

A. HT command makes the turtle invisible from the screen.

ST Logo primitive is used to show the turtle on the

screen.

8. Write a short note on PE command.

A. This command erases the lines drawn by the turtle. The

turtle is moved to the line that is to be removed

II. Fill in the blanks.

1. Home 2. CS 3. FD (forward)

4. RT(right) 5. BK (backward)

III. Match the following

1. E 2. C 3. D 4. B 5. A

IV. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3. F 4.T 5. F

III. Tick the correct answer

1. B 2. A 3. A 4. A 5. A
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10. Arithmetic with MSW Logo

I. Answer the following questions.

1. What are the uses of arithmetic operators in Logo ?

A. In logo we use arithmetic operators to perform

arithmetic calculations like addition, subtraction,

multiplication and division.

2. What is the use of SUM operation ?

A. The sum operation is used to add two or more numbers.

3. Explain about PRINT command.

A. This command is used to write numbers, words or

sentences on the Recall List Box on Logo screen. The

syntax of print command is: PRINT (number) or PR

(number)

4. What will be the output of the command PR QUOTIENT

1000 500 ?

A. It will print 2 on the screen.

5. How will you multiply two numbers in

MSWLogo?Write both the methods.

Multiplication combines two numbers into single

number. Asterisk (*) symbol is used to multiply two

numbers in the computer.

Z PR 3*5

Z PR PRODUCT 3 5

It will print 15 on the screen.

6. Write about division ?
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A. Division is the inverse of multiplication. The slash (/)

symbol is used to divide one number by another.

Type: PR 60 / 30 Type: PR QUOTIENT 150 30

It will print 2 on the screen. It will print 5 on the screen

II. Fill in the blanks.

1. Print 5. Sum

2. quotient 6. LOVE MY INDIA

3. * or PRODUCT 7. WEALTH

4. 40

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. F 3. T 4. F 5. F

III. Complete the following

1. 50 2. 1205 3. 100

4. 300 5. PR PRODUCT 201 10
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Computer level 5

1. Exploring Internet

I. Answer the following questions.

1. Define internet.

A. Internet is a global network of millions of computers

and computer network all over the world. It allows us

to access and share information over the network.

2. Name any three social networking websites?

A. face book ,instagram, twitter,youtube, whatsapp

3. What do you mean by downloading ?

A. Getting the data from the host computer (server) to the

client computer (user's computer) is known as

downloading.

4. Write any two uses of internet ?

A. E-mail is one of the uses of internet .It is an online

communication system. With e-mail, you can send and

receive electronic messages which work like writing

letters.You can buy and sell products all over the world

through the Internet. It is called online shopping.

5. What are the things required to connect to internet ?

A. computersystem ,telephone and cable lines,modem ,web

browser and ISP

II. Fill in the blanks.

1. Information 2. Search engines 3. Downloading

4. Uploading
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I. Identify the following icons and write the names in the

space provided.

1. google chrome 2. facebook 3. gmail

4. Whatsapp

2. Introduction to MS word 2010

I. Answer the following questions.

1. What is the use of the print layout view ?

A. The print layout view shows the document as it will

look when it is printed.

2. What is the use of the web layout view ?

A. Web Layout view enables you to see your document as

it would appear in a browser such as Internet Explorer.

The page breaks in the document are not visible in this

view. The whole document becomes one page.

3. What does the Status bar do ?

A. This is the horizontal stripe at the bottom of Ms-Word

window and it gives information about the document.

i,e. current location of the cursor point line column page

number etc.

4. Write short notes on the Draft view ?

A. Draft view is the most frequently used view- You use

Draft view to quickly edit your document. The pictures

in the document are not visible in this view.

5. Where are the scroll bars located in the MS Word screen ?
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A. The bars which are located on far right or bottom of

window are called Scroll Bars. They are used to view

different portions of document.

6. Write a short note on Ribbon option ?

A. The ribbon is a user interface element created by

Microsoft. The Ribbon is a collection of tabs in a panel

at the top portion of the document. It is designed to help

us to find the commands quickly to complete a task.

II. Fill in the blanks.

1. Word processing

2. Tabs

3. Save, Undo and Redo

4. Horizontal and Vertical

5. Work area

III. Write true (T) for a correct statement and false (F)for

an incorrect statement

1. F 2. F 3. F 4.T 5. F 6. F

I. Match the following.

1. C 2. D 3. B 4. A

3. Working with a Document
I. Answer the following questions.
1. Write the steps to create a new document in MS Word

2010.

Z Click the File tab. This takes you to Backstage view.

Z Select New.
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Z Select Blank document under available Templates. It

will be highlighted by default.

Z Click Create. A new blank document appears in the Word

window. (Or)

Z Press Ctrl+N to create a new document quickly.

2. Write the steps to save a file in web page format.

A. To save a document click on the Microsoft office button
and click save option, a new window appears. Now type

a file name and click on save button.
3. Write the difference between save and save as options ?

A. Save
To save a document for the first time the save option is

used. Each time when this option is used the document
is simply saved with the same name. The keyboard

shortcut for saveoption is Ctrl + S.
Save As

To make a copy of the document the Save As option is
used. Each time when this option is used the document

is saved with different name or location or both. The
keyboard shortcut for Save As option is F12.

4. Write the steps in closing a document?
A. After working with a File it should be saved and closed.

To close following steps should be taken

Z Click on the File tab

Z Click on Close option

5. Write the steps in closing the application.

A. After completion of working with MS -Word it should
be closed the following are the steps to close MS Word.
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Z Close all the Document windows.

Z Close the application by clicking at the Close button on

the top right corner of the Title bar. (Or)

Z Click on the File tab and click on the Exit button.(Or)

Z Press Alt+F4 in the keyboard.

II. Fill in the blanks.
1. Ctrl+N 4. Print option

2. Info option 5. ALT+F4
3. File

III. Write true (T) for a correct statement and false (F) for
an incorrect statement

1. T 2. F 3. F 4. F 5. T
I. Match the following.

1. C 2. D 3. B 4. E 5. A

4. Editing text in a Document

I. Answer the following questions.

1. Write the Steps to select a block of text.

A. Steps to select a block of text with mouse or key board.

Point to the first or final character of the text to be

selected.

Z Press and hold the left mouse button.

Z Drag across the text to the final or first character to be

selected.

Z Release the mouse button. (Or)

Z Place the insertion point at one end of the text to be

selected.
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Z Press shift and click at the other end of the text to be

selected.

2. How can you select a sentence?

A. Hold down CTRL, and then click anywhere in the

sentence. Release the Ctrl key. End punctuation and

trailing spaces are automatically selected along with the

sentence.

3. How can you select a paragraph?

A. Triple-click anywhere in the paragraph or Point in the

selection bar next to the paragraph and double-click the

mouse button. The ending paragraph mark is selected

along with the paragraph.

4. Write the steps to find a word in a document.

Z Select the Home tab.

Z Click Find in the Editing group or press Ctrl +F.

Z Type the text you want to find in the dialogue box.

Z If the text is found in the document, it will be highlighted

in yellow.

Z You can click on the find next button to find more

occurrences.

5. Write a short note on cut, copy and paste option ?

Z Copy option is used to make a copy of the selected text

or the whole text in the same document or in a different

document at the cursor position.

Z Cut option is used to move a portion of the text from

one part of the document to the other position in the
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same document or can be placed in some other document

too.

Z Paste option is used to insert the contents of the text

that you cut/copied to the cursor position where the

desired text is required.

II. Fill in the blanks.

1. Ctrl 4. Ctrl+R

2. Ctrl+A 5. Replace

3. Ctrl+F

I. Write down the keyboard shortcuts for the following

1. Ctrl+A 4. Ctrl+F

2. Ctrl+X 5. Ctrl+R

3. Ctrl+V

I. Match the following.

1. E 2. D 3.A 4.B 5. C

5. Formatting the Text

I. Answer the following questions.

1. How can you change the Font of a text using the Ribbon?

A. Select the text you want to change, On the Font group

of Home tab, type a Font Name in the Font box or select

from the drop down combo.

2. Write the steps to change the font size using the ribbon.

A. Select the text by highlighting. Type a font size in the

Font Size combo box or select from the drop down

menu. See the live preview of the text and select the
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size. Or Press Ctrl + Shift + > key to increase the font

size and Ctrl + Shift + < key to decrease the font size

using the keyboard. Font size can be measured in points.

3. How can you change the font style of a text using the

font dialog box ?

Z Changing font using the font dialog box

Z Select the text you want to change.

Z Click on the Font dialog box launcher to get the font

dialog box.

Z Select the font from the drop down list of fonts.

Z Click at Ok.

4. What are the keyboard short cuts used to change the

font style ?

Z Press Ctrl+B to bold the selected text.

Z Press Ctrl+I to italicize the selected text,

Z Click Ctrl+U to underline the selected text.

5. Write the steps to change the font color of a selected

text.

A. Changing Font Color

Z Select the text by highlighting.

Z Click on the Font Color button under Font group of

Home tab.

Z Select the desired color from the color box.

Z To More Colors..from the Color Palette.

Z Select a color and click on Ok.

6. Write about text alignment
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A. There are four buttons available for aligning text.

Z Align Left : By selecting this button the text in the

document is aligned with the left margin of the page.

Z Center : This button centers the text within the page

margin.

Z Align Right : By selecting this button the text in the

document is aligned with the right margin of the page.

Z Justify : This option aligns the text evenly along both

the left and right margins. This option creates an even

edge on both the sides by adding extra space between

the words.

II. Fill in the blanks.

1. Font 5. Points

2. Ctrl + Shift + > 6. Italic

3. Many 7. Bold

4. 8 and 72

III. Match the following.

1. C 2. E 3. A 4. F 5. D 6. B

6. Paragraph Formatting

I. Answer the following questions.

1. Write the steps to change the line spacing of a paragraph.

A. Select the Desired Paragraph(s).

Z Click at Paragraph launcher to open Paragraph dialog

box.

Z Click at the Indents and Spacing tab.

CYBERWAVE 73 Computer Level - 5



Z Select the desired Line Spacing setting from the

LineSpacing list box.

Z Click at OK.

2. Write the steps to change the alignment of a paragraph.

A. Setting Alignment by using Paragraph dialog box

Z Select the desired paragraph(s).

Z Click at Paragraph dialog box launcher to open

Paragraph dialog box.

Z Click at the Indents and Spacing tab.

Z Select the desired Alignment setting from the Alignment

list box.

Z Click OK.

3. Write the steps to insert a page break manually.

A. It can be inserted into a document by the user. A Manual

page break appears as a tightly spaced dotted line with

the word page break in the center of the line.

Steps to insert Page break

Place the Insertion Point immediately to the left of the

First Character that is wanted in the new page. Click

Insert tab. Click on the Page Break button.

4. Write the steps to add bullets to some paragraphs.

A. Steps to Add Bullets

Z Select the words you just typed.

Z Choose the Home tab.

Z In the Paragraph group, click the down arrow next to

the Bullets button.
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Z TheBullets Library appears.

Z Click to select the type of bullet you want to use.

Wordadds bullets to your list.

5. Write the steps to add numbering to some paragraphs

A. Steps to add Numbering

Z Select the words you just typed.

Z Choose the Home tab.

Z In the Paragraph group, click the down arrow next to

the Numbering button. The Numbering Library appears.

Z Click to select the type of numbering you want to

use.Word numbers your list.

6. Write about subscript and superscript.

A. Superscript and subscript refer to numbers or text that

are positioned slightly higher or slightly lower than the

text on the line. For example, a foot note or end note

number reference is an example of superscript, and

scientific formulas are example for subscript text.

Example :

Z Super Script (A + B)2 AN x AM= AM+N A2+B2

Z Sub Script Na2, CO2 ,Na2 S04

7. Write about spell check and synonym.

A. Any spelling or grammatical mistake in the document

can be easily identified as MS Word 2010 underlines

the words with the red line for spelling mistakes and all

the grammatical errors in blue and for extra space,

capitalization etc, in green.
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Right click the word in your document. A popup menu

appears. Click the synonym button, you will find a list

of words with similar meaning. If you want to replace

the word with synonym suggestions just click on the

word that is suggested. The old word will be replaced

with the new word.

II. Fill in the blanks.

1. Four 4. Spellcheck

2. Six 5. Paragraph

3. Two

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. F 3. F 4. T 5. F

II. Match the following.

1. B 2. C 3. D 4. E 5. A

7. Working with tables and Borders

I. Answer the following questions.

1. What is table ?

A. A table is a collection of rows and columns. Intersection

of a row and column forms a cell. Rows are horizontal

segments and columns are vertical. Tables are used to

organize and present information in a tabular form.

2. Write the steps followed in the creation of table?

Z Click at the point in your document where you'd like to

add a table.

Z Click on the Insert ribbon tab.
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Z Click on the Table button just below the lnsert tab. Move

the mouse over the grid of rows and columns to highlight

how many rows and columns you need.

Z Click the left mouse button.

Z The table will appear with the number of rows and

columns you highlighted.

3. What is merging? Explain the different ways in which

we can merge cells?

A. You can combine two or more table cells located in the

same row or column into a single cell. For example,

you can merge several cells horizontally.create a table

heading that spans several columns.

Z Select the cells that you want to merge by clicking the

left edge of a cell and then dragging across the other

cells that you want.

Z Click on Merge Cells button under the Merge group of

the Layout tab.

4. Write about formula option?

A. MS Word table also allow us to manipulate numerical

data and other calculations. This can be done with the

Formula option.

5. How can you add a coloumn to a table?

Place the insertion point in a coloumn adjacent to the

location where you wish the new column to appear

Z Right click the mouse a menu appears.

Z Select insert point. Select Insert Columns To The Left

or Insert Columns To The Right. A new column appears
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6. How can you delete a row or coloumn?

Z Select the row or column.

Z Right-click your mouse, and a menu appears.

Z Select Delete cells option. The delete cells dialog box

appears.

Z Select the desired option from the dialog box and click

on OK.

7. How can you add borders to your table ?

A. You can add or remove borders to format a table the

way that you want, table borders

Z Under Table Tools, click the Layout tab.

Z In the Table group, click Select, and then click Select

Table

8. How can you draw a table ?

Z Click where you want to create the table.

Z On the Insert tab, in the Tables group, click Table, and

then click Draw Table.

Z The pointer changes to a pencil

Z To define the outer table boundaries, draw a rectangle.

Z Then draw the column lines and row lines inside the

rectangle.

Z To erase a line or block of lines, under Table Tools, on

the Design tab, in the Draw Borders group, click Eraser

Z Click the line that you want to erase,

Z When you finish drawing the table, click on a cell and

start typing.
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II. Fill in the blanks.

1. cell 4. Draw table

2. Rows, column 5. Insert ribbon tab

3. Merge cells

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. F 3.T 4.F 5. T

II. Match the following.

1. B 2. C 3.D 4.E 5. A

8. Working with Graphics
I. Answer the following questions.

1. How can you insert an equation in your word document ?

Z Place your cursor in the document where you want the

symbol.

Z Click the Equation button on the Symbols group of the

Insert tab.

Z Choose the appropriate equation and structure or click

Insert New Equation.

Z To edit the equation click the equation and the Design

tab will be available in Ribbon.

2. Write the steps to insert a picture in your document.

Z Place your cursor in the document where you want the

illustration/picture.

Z Click the lnsert tab on the Ribbon.

Z Click the Picture button.

Z Browse to the picture you wish to include.
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Z Select the Picture & Click lnsert.

3. How can you insert a smart art in your document ?

Z Place your cursor in the document where you want the

illustration/picture.

Z Click the Insert tab on the Ribbon.

Z Click the SmartArt button.

Z Click the SmartArt you wish to include in your

document.

Z Click the arrow on the left side of the graphic to Insert

text or type the text in the graphic.

4. What is a word art ?

A. Sometimes we need to decorate the document with

stylized writing instead, of plain writing. WordArt

allows us to use special effects like twisting, bending

and rotating text in the document. Any text can be

formatted and there is a gallery from which styles can

be selected.

5. How can you resize a picture ?

A. All graphics can be resized by clicking the image

clicking one corner of the image and dragging the cursor

to the size you want the picture.

6. What is a water mark ?

A. Watermark is a translucent image that appears behind

the primary text in a document

7. What are auto shapes ?
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A. You can add a variety of shapes to your document,

including arrows, squares, stars, and flow charts

symbols. The shapes can be formatted by changing their

fill with color, outline color, shape style and shadow

effects.

II. Fill in the blanks.

1. Insert 4. Page layout

2. Equation 5. Insert

3. Picture

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3. F

II. Match the following.

1. B 2. C 3.D 4.E 5. A

9. Printing and page setup
I. Answer the following questions.

1. Write the steps to see the print preview of a document.

A. To preview a document click on the Microsoft Office

button → Print Preview. The buttons of print Previewtool

bar provides various options

2. Write about print preview option ?

A. This print Preview option is useful to view your

document, as it would be appear on paper after taking

print out. Print Preview option shows the preview of

the current page or all the pages in a document as it

would appear after taking the print out.
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3. Write the steps to change the page orientation of a

document.

Z Select the Page Layout tab.

Z Click the Orientation command in the Page Setup group.

Z Click either Portrait or Landscape to change the page

orientation.

Z Landscape format means the page is oriented

horizontally, while portrait format it is oriented

vertically.

4. Write the steps to print a word document.

A. Steps to print:

Z Go to the Print pane.

Z If you only want to print certain pages, you can type a

range of pages. Otherwise, select Print All Pages.

Z Select the number of copies.

Z Check the Collate box if you are printing multiple copies

of a multi-page document.

Z Select a printer from the drop-down list.

Z Click the Print button.

5. Write the steps to change the page size of a document.

Z Select the Page Layout tab.

Z Click the Size command, and a drop-down menu will

appear. The current page size is highlighted.

Z Click the size option you want. The page size of the

document changes.

II. Fill in the blanks.
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1. File 4. 2

2. Page layout 5. Size command

3. Current

I. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3.F 4.T 5.F 6. F

10. Pivot Animator

I. Answer the following questions.

1. What is an animation? Name different types of

animations.

A. Animation is a method by which still figures are

manipulated to appear as moving images.There are

many different types of animation but most of them fall

into five major categories

Z Traditional Animation

Z 2D Animation

Z 3D Animation

Z Motion Graphics

Z Stop Motion

2. What are the components of figure controls ?

A. Add figure, delete, edit, centre, flip, raise, paint, copy, join,

scale and transparency are the components of pivot figure.

3. What are frame controls ? Explain ?

A. Frame controls are Repeat, Delete, Copy and Paste.

Repeat : It is used to repeat the selected frame for a

certain number of times.
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Delete : It is used to delete the frames.

Copy : It is used to copy a frame

Paste : It is used to paste/ insert a copied frame.

4. Write about playing an animation.

A. After adding frames to the time line, the animation can be

played by clicking the play button in the player controls.

Play : Play the animation from the beginning (or) from

the frame being edited.

5. Write in steps to save the animation.

A. After creating an animation by adding frames to the time

line, the animation can be saved with desired name

Step 1 : Click on file menu

Step 2 : Click on save animation, save as dialogue box

appears.

Step 3 : Enter the name of the file and click on save.

6. Write in steps to change the color of the stickman.

A. Step 1 : Select the stickman(by clicking origin handle).

Step 2 : Click on figure colortool, colorpallete will be

displayed.

Step 3 : Choose the required color from the colorpallete.

Step 4 : Click on ok button, the stickman color will be

changed.

II. Fill in the blanks.

1. An Animation 2. Time line 3. Frame

4. Delete option 5. Loop

III. Match the following

1. e 2. c 3. d 4. f 5. b 6. a
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11. Advanced Pivot Animator
I. Answer the following questions.
1. What is a Time line ?
A. Time line : A Time line is a small area on the top of the

window that displays all the frames in the animation.
2. Define animation and frame.

Animation: An Animation can be created by creating a
series of frames, where each frame differs slightly from
the previous.
Frame: A Frame is the image that you see/ visualize at
any point of time in an animation,

3. Write the steps to insert and delete the frames.
A. Frames can be inserted and deleted on the time line. Right

click on any frame in the time line, a pop menu appears.
Insert : To insert a new frame.
Paste Insert : To insert copied frames after the selected
frame.

4. Write steps, to load figure type.
A. Step 1 : Click on file menu.

Step 2 : Select load figure type, open dialog box displays
with default figures
Step 3 : Choose any figure type (eg: Click on elephant).
Step 4 : Click the open button in the open dialog box.

II. Fill in the blanks.
1. copy 2. Frames 3. Segments 4. Flash
5. loop 6. Centre 7. Frame 8. .piv

III. Write true (T) for a correct statement and false (F) for
an incorrect statement.
1. T 1. T 1. T 1. F 1. F 1. T
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Computer Level 6

1. Introduction to MS Excel 2010

I. Answer the following questions.

1. Where does the name of the current workbook appear?

A. On the title bar, Microsoft excel displays the name of

the current work book and the application name.

2. What does the ribbon contain ?

A. Ribbon contains commands organized in three

components:

Tabs: They appear across the top of the Ribbon and

contain groups of related commands. File, Home, Insert,

Page Layout are example of tabs.

Groups: They organize related commands; each group

name appears below the group on the Ribbon. For

example group of commands related to fonts or group

of commands related to alignment etc.

Commands: Commands appear within each group as

mentioned above.

3. What is the default number of rows in a MS excel 2010

work sheet?

A. By default number of rows in MS Excel 2010 worksheet

are 10, 48,576 rows.

4. What does the status bar do?

A. The Status bar appears at the very bottom of the Excel

window and provides such information as the sum,
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average, minimum, and maximum value of selected

numbers.

5. Write the history of MS Excel ?

A. MS Excel 2010 is advanced software which can perform

several functions on text and numerals simultaneously.

MS Excel 2010 is proficient software which combines

formatting features with automatic calculating features.

It can also perform several advanced functions, graphs

and charts.

6. Draw the MS excel 2010 screen neatly and mention the

parts ?

7. What is the uses of quick access tool bar ?

A. The Quick Access Toolbar helps us to access the

frequently used commands. In other words, it is a

shortcut to frequently used commands. By default only

three buttons appear on this tool bar namely Save, Undo

and Redo.

II. Fill in the blanks.

1. Multiplan 4. Application

2. 1985 5. Top left

3. 2

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3.T 4.T 5. T

II. Match the following.

1. D 2. E 3.B 4.C 5. A
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2. Working with worksheet

I. Answer the following questions.

1. What are the input devices used to navigate in the Excel

sheet ?

A. The keyboard and the mouse can be used to move around

the worksheet. The four arrow keys and the four

destination keys ie.PgUp, PgDn, Home and End key

are used to move around the worksheet.

2. What are the keys used for navigation in an Excel sheet ?

Z The Down Arrow Key is used to move the cursor

downward one cell at a time.

Z The Up Arrow Key is used to move the cursor upward

one cell at a time.

Z The Right Arrow Key is used to move the cursor one

cell right at a time.

Z The left Arrow Key is used to move the cursor one

cellleft at a time.

Z The Tab Key is used to move the cursor one cell right at

a time.

Z The Shift + Tab keyis used to move the cursor one cell

left at a time.

3. What is the use of the Ctrl key in navigating in Excel ?

A. The Ctrl key is used faster navigation in MS Excel.

4. What is the use of the name box ?

A. You can also use the Name box to go to a specific cell.

Just type the cell address you want to go to in the Name
CYBERWAVE 88 Computer Level - 6



box and then press Enter. Type C3 in the Name box.Press

Enter. Excel moves to cell C3.

5. Write about Gotocommand ?

A. The F5 function key is the "Go To" key. If you press the

F5 key, you are prompted for the cell to which you wish

to go. Enter the cell address, and the cursor jumps to

that cell. Press F5. The Go To dialog box opens. Type

J3 in the Reference field.Press Enter. Excel moves to

cell J3.

6. How can you select a range of cells ?

A. You can select an area by holding down the left mouse

button and dragging the mouse over the Area.

7. What are the ways used to give commands in Excel 2010 ?

A. Excel commands can be given in one of the following

ways:

Z Choosing an option from the Tab and Ribbon.

Z Choosing an option from the shortcut menu.

Z Select a tool from the Quick Access toolbar.

II. Fill in the blanks.

1. Down arrow 3. Alt + PG dn

2. Left arrow 4. PG up

I. Write true (T) for a correct statement and false (F)for

an incorrect statement

1. F 2. T 3. T 4. T 5. F 6. T

II. Match the following.

1. E 2. C 3. D 4. B 5. A
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3. Entering data in Excel

I. Answer the following questions.

1. What are the symbols can be used in numbers in MS

Excel 2010 ?

A. Numbers can be entered with commas, dollar signs,

percentsigns and scientific notation.

2. What is the way to enter a negative number in MS Excel ?

A. Negative numbers should be preceded with a minus sign

or should be enclosed within parentheses

3. How can you enter a fraction in a cell.?

A. Fractions can also form a part of the spreadsheet. To

enter a fraction, the whole number and the fraction

should be separated by a space. If the fraction does not

have the whole part, a zero should be placed in front of

the Fraction, for example 0 2/5

4. What are the rules to be followed while entering date or

time in an excel sheet ?

Z On the worksheet, click a cell. Type a date or time as

follows:

Z For a date, use a slash mark or a hyphen to separate the

parts of a date; for example, type 9/5/2002 or 5- Sep-

2002.

Z To enter the current date, press CTRL+; (semicolon).

Z For a time that is based on the 12-hour clock, type a

space, and then type a or p after the time; for example,

9:00 p. Otherwise, Excel enters the time as AM.
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Z To enter the current time, press CTRL + SHIFT + ;

(semicolon).

5. Write the steps to enter current date and time into a cell.

Z To enter the current date, press CTRL+; (semicolon).

Z To enter the current time, press CTRL + SHIFT + ;

(semicolon).

II. Fill in the blanks.

1. Decimal point 5. Ctrl+;

2. minus 6. CTRL+SHIFT+;

3. 15 7. Autofill

4. space

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. F 3. T 4. T 5. T

II. Match the following.

1. D 2. E 3. C 4. A 5. B

4. Editing the worksheet in Excel

I. Answer the following questions.

1. Write the steps to edit the content of a cell.

A. Double click on the cell. The data in the cell is ready

for editing. Press the back space key and delete

2. How can you check the spellings of the words in an

Excel sheet ?

A. Using the Spelling option of the Review tab, the

spellings of words in worksheets and charts can be

checked and corrected. The user can either check the
CYBERWAVE 91 Computer Level - 6



spellings in an entire worksheet a range of cells or even

a single cell.

3. Write the steps to move the content of a range of cells

from one place to another.

A. Cell contents can be moved from one area in the

worksheet to another by using: Cut, Copy and Paste

commands from the Home tab.

Steps:

Z Select the cell/cells to be moved.

Z Select Cut command from the Home tab/short cut menu.

Or press Ctrl+X

Z Select destination cell.

Z Select Paste command from the Home tab/ short cut

menu. Or press Ctrl+V

4. Write the steps to copy the content of a cell and paste it

in another cell.

Select the cell/cells you want to copy (by placing the

mouse pointer at the upper left corner of the cells to be

moved and dragging it towards its bottom-right.)

Z Click copy button from the Clipboard group of the Home

tab.

Z Select the destination cell.

Z Select Paste command from the Clipboard group of the

Home tab.

Z Ctrl + C is short cut for copy.
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Z Ctrl + V is short cut for paste.

5. Write the steps to insert a row in your worksheet.

A. To insert rows, the Home → Insert → insert Sheet Rows

command is used. On inserting new rows, existing rows

shift down

6. How can you delete a column from your work sheet ?

A. To delete a column, select a cell of the column, then

choose Home -Delete -Delete Sheet Columns. Place the

mouse pointer on column heading .right click and select

Delete column option.

II. Fill in the blanks.

1. F2 4. Review

2. Z 5. Home

3. Quick access

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. T 3. F 4. F 5. F

IV. Match the following.

1. B 2. C 3. D 4. E 5. A

5. Formatting Features of Excel

I. Answer the following questions.

1. What do you mean by cell formatting?

A. The cell formatting refers to applying several formats

to the cells. The Number, Alignment, Font, Border, Fill
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and Protection of cell contents can be manipulated using

Font group and Number group of the Home tab

2. Discuss the alignment tab of the cell formatting dialog

box ?

A. There are six buttons available for aligning text.

Z Left Alignment : By selecting this button the text is

aligned to the left of the cell.

Z CenterAlignment : This button aligns text to the center

with in the cell. Right Alignment : By selecting this

button the text is aligned to the right of the cell.

Z Top Alignment : This button aligns the text to the top of

the cell.

Z Bottom Alignment : This button aligns the content to

the bottom of the cell.

Z Middle Alignment : This button aligns the content to

the middle of the cell.

3. Write a note on font style?

A. Font styles are pre-defined formatting options that are

available in MS Excel . The three different styles

available are Bold, Italic and Underline.

Z Bold : This style makes the text appear darker than

normal. (Ctrl + B)

Z Italic : This style makes the text appear slanted. (Ctrl + I)

Z Underline : This style underlines the text. (Ctrl + U)

4. Write in detail about formatting rows and columns ?

CYBERWAVE 94 Computer Level - 6



A. Row height and column width can be altered for the

data to fit in. To change the height dimensions of the

rows, click on Home tab, select Format button from

theCells group.

Similarly, the column dimensions can also be changed.

To change the width measurement, click on the Home

tab, select Format button from the Cells group.

5. Write about orientation ?

A. The Orientation button is used to change the direction

of text to diagonal or vertical. Orientation is used mainly

for labelling narrow columns. To rotate the text Click

the Orientation button. Now drop down list appears

select the angle which suits your need

6. Write about sorting ?

A. Sorting refers to the action of arranging a list of items

in a specific order which can be ascending or

descending. This can be done by selecting the Sort

&Filter of the Data tab.

II. Fill in the blanks.

1. Points 4. Filter

2. Cell formatting 5. Auto filter

3. Font 6. Ascending, Descending

I. Match the following.

1. C 2. D 3. E 4. F 5. A 6. B
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ACTIVITY BASED LEARNING

II. Write names of the following icons.

1. sort and filter 2. fillcolor 3. Auto sum

4. copy 5. Cut

6. Calculations in MS Excel

I. Answer the following questions.

1. Give the advantages of using the formulas?

A. Formulas help to manipulate the data and performsimple

as well as complex calculations efficiently.The formulas

in excel start with an equal sign (=) and it can be a

maximum of 1024 characters in length. As soon as the

formula is entered, it gets displayed on the formula bar.

Formulas are stored in cells like data. But they display

the result of the calculation in the cell rather than in the

formula bar.

2. Name and explain the different types of operator in excel ?

A. Operator Meaning Example

+ Addition = A1+A2

- Subtraction = C3-C1

/ Division = B1/B5

* Multiplication = A1*A2

% Percentage = A2%

A Exponentiation = A2AA3

3. What are the various logical functions ?
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A. The functions in this category are used to examine

conditions. The return value of the logical function is

either True or False depending on whether the condition

is satisfied or not.

4. Write a few lines on date and time functions?

A. Excel provides several Date/ time functions to perform

calculations with date and time values. To insert Current

Time into a cell press, CTRL + : (colon)To insert Current

Date into a cell press, CTRL + ; (semicolon)

5. What is function? How it is useful for excel?

A. Functions are special pre-written formulas that take a

value(s), perform an operation and return a value(s) in

the cell in which they are entered. It simplifies and

shortens the formulas in the worksheet in place of

lengthy and complex calculations. All the functions

begin with an equal to (=) sign.

6. Explain about statistical and text functions?

A. Statistical functions are those used on a group of values

and perform statistical calculations.Statastical functions

are average, max, min, count. AndText functions enable

you to manipulate the text values by concatenating

thevalues and extracting a part of the string. The text

functions are :Concatenate,exact, len, left, right
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II. Fill in the blanks

1. formulae 4. Ctrl+I

2. data 5. =

3. mixed addressing

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. True 2. False 3. True 4. True 5. True

II. Match the following

1. B 2. D 3. E 4. A 5. C

7. Graphics in MS Excel

I. Answer the following questions.

1. Write the steps to insert a clip art in your document.

A. Clip art gallery is a picture gallery, which is in-built in

Office package. It contains Pictures, Videos, sounds etc.

To open ClipArt gallery click on Insert tab and select

ClipArt button from the Illustrations group.

2. Write the steps to insert a picture saved in your computer

into your document.

Z Click where you want to insert the picture.

Z On the Insert tab, in the Illustrations group, click Picture.

Z Select the picture that you want to insert.

Z Click on Insert button.

3. How can you draw a shape in excel 2010 ?

Z Click Shapes on the Insert tab of the Illustrations group.
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Z Click the shape that you want, click anywhere in the

workbook, and then drag to place the shape .

Z Drag until the shape is the size that you want.

4. How can you insert a text box in your document ?

A. To insert a text box. Click Text Box on the Text group

of Insert tab.

Bring the mouse pointer to the sheet and drag from one

place to another.

Now you can enter text in the text box.

5. Write the steps to change the fill color of a WordArt.

Z Select the WordArt.

Z Highlight the text by dragging. Right click on the

WordArt.

Z Select Format Text Effect from the short cut menu.

Z Click on the Text Fill tab and make the necessary change

in the dialog box.

Z CIick on the close button.

6. How can you remove the word art style?

A. When you remove the WordArt style from your text,

the text remains and changes to plain text. Select the

WordArt text that you want to remove the WordArt.

PressCtrl + Spacebar.

7. What are charts and what are the steps followed in the

insertion of charts ?
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A. Charts are graphical representations of tabular data.

They can be inserted into spreadsheets.To insert a chart

into the worksheet follow the steps given below:

Step 1: Select the range of data.

Step 2: Click on the Insert tab of the ribbon.

Step 3: From the Charts group, select the type of chart.

Step 4: Select the subdivision as per the requirement.

Now the chart appears on the worksheet.

II. Fill in the blanks.

1. Insert tab 4. Text box

2. Several 5. Insert and Clipart

3. Delete

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3. F 4. T

III. Match the following.

1. D 2. E 3. C 4. A 5. B

8. Saving, opening&printing in MS Excel 2010

I. Answer the following questions.

1. What is page set up ?

A. Page setup refers to the way in which the margins, paper

source, size and other layout options will be applied on

the document.

2. Define header and footer ?

A. Header is an area at the top of the page where special

information like title, subject name etc., are inserted.
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Footer is the area at the bottom of the page which

contains page number, end notes etc. To insert header/

footer, Click on Insert Tab and click Header & Footer

buttonfrom Text group.

3. How do we print a worksheet ?

A. The Print option under Ms Office button prints the

document on paper as required by the user. Certain

procedures are to be followed before the page can

actually be printed.

4. Write a note on Orientation button ?

A. Every document has its own layout that suits its printing

mode. Fixation of this layout is called orientation.

According to the data, one may need to place it

lengthwise or widthwise on paper. The default page

orientation is portrait (length wise) and the other

orientation is landscape (widthwise).

5. Detail the buttons of print preview dialog box ?

A. The Print Preview option under file button shows how

a file will look when it is printed. This option shows the

preview of the current page or of all pages when it

isprinted. This is needed when a few lines of data

overflow to the next page. To avoid inconvenience in

reading such data, scaling can be used. pages in a

document. The user can get the preview of the worksheet

by clicking print button.

6. Write the steps to save a workbook ?
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Z Click on the File tab and select the Save or Save As

option.

Z Type a name for the workbook in File name text box in

the Save As dialog box.

Z Select Excel Workbook from the Save in Type

Z Click on the Save button.

7. How can you open a workbook saved earlier ?

Z Click on the File tab.

Z Click on Open command. (The Open dialog box

appears).

Z Select the desired file.

Z Click on Open.

II. Fill in the blanks.

1. Footer 4. Page up

2. orientation 5. Selection

3. scaling 6. Portrait, landscape

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. F 3. T 4. T 5. T

9. Introduction to Scratch

I. Answer the following questions.

1. What is a sprite and what is its purpose ?

A. It is an object that performs an action on stage. By

default, you see the sprite, a cat in the centre of the

stage. The sprite can move left, right, up or down using
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the arrow keys. It can also rotate or bounce from the

edge of the screen.

2. List the block categories.

A. There are nine categories of blocks namely, Motion,

Looks, Sound, Events, Control, Sensing, Operators,

Variables and My Blocks.

3. Why are the block categories color-coded ?

A. The block categories are color-coded so when you see

a block of a specific color, you can quickly conclude its

category.

4. What is a block palette ?

A. The block palette consists of every block that is built

into Scratch. Some of the blocks take on certain values

by default, while others are associated with sprite's

current values.

5. How can you move a sprite in Scratch ?

A. To move a sprite, you have to use the move block under

the Motion block palette.The sprite moves forward with

the specified number of steps in the direction it is facing.

A step is equal to one-pixel length.To make the sprite

move backwards, use negative numbers.

II. Fill in the blanks with the help of given words.

1. Scratch 2. MitchelResnick 3. Sprite

4. stage 5. script

III. Write (T) for true and (F) for false statements.

1. F 2. F 3. T 4. T 5. T
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IV. Choose the correct option.

1. C 2. B 3. C 4. C 5. D

10. Blocks & Coding in Scratch

I. Answer the following questions.

1. How many block shapes are available in Scratch ?

A. There are six different block shapes: Hat, Stack,

Boolean, Reporter, C and Cap.

2. How will you turn a sprite to 180 degrees ?

A. Step 1 : To turn the sprite, select the block   turn 15

degrees   from the Looks block palette.

Step 2 : Drag it onto the Scripts Area.

Step 3 : Double-click the block in the Scripts Area.

3. What is the color code for Motion, Looks, Sound and

Events blocks ?

A. Motion-Blue, Looks-Violet, Sound-Red, Events-Yellow

4. List two blocks from each of the following block

categories.

a) Motion
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The sprite points towards the mouse

pointer or another sprite

The block sets the sprite's X and Y

position according to the specified

co-ordinates on the stage



b) Looks
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The block gives its sprite a speech

bubble with the given text.

It displays a speech bubble with the

specified text for the specified seconds.

c) Sound

5. How will you run the code by pressing Spacebar key ?

A. Script placed underneath this block will activate when

thespecified key is pressed

II. Fill in the blanks with the help of given words.

1. Motion 2. Pen 3. Sound

4. Meow 5. Script

III. Choose the correct option.

1. B 2. C 3. C 4. B 5. D

IV. Write (T) for true and (F) for false statements.

1. T 2. F 3. T 4. T 5. T

It will play the specified sound without a pause

It will stop any sounds currently being

played on all sprites.
d) Pen

Clears the screen

This block stops to continue making a trail

e) Events

Script under this block activates once it is clicked.

Scripts placed underneath this block

activate once its sprite is clicked.
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11. Coding & Gaming in scratch

1. List the conditional blocks.

A. Conditional statements are found in the Control block

with if and wait blocks and they return true or false

values and execute only if the statement is true.The If

block executes the code under It, only if the condition

is true else it doesnothing.The if-else block executes

the code under the if block, if the condition is true, else

it executes the code under the else block.

2. Compare repeat and forever blocks.

A.

4. What is costume ?

A. A costume is an alternate appearance of a sprite. Sprites

can change their look to any of its costumes and the

effect is used to make an animation for a game or stories.

3. Write about any 3 of sensing blocks.

A. Sensing block

A loop that repeats the specified number of

times.

A loop that will never end

It asks the user to enter the information

or text and then waits

It checks for true value if the sprite is

touching another sprite, edge of the

stage or the mouse pointer

It gives results as true if the specified

key is pressed by the user.



Computer Level 7

1. Glimpe on E-mail

I. Answer the following questions.

1. What is E-mail and write down how to use E-mail ?

A. An electronic mail or e-mail is the most popular feature

of the Internet. It is an easy, fast, inexpensive and time

saving media of receiving and sending messages to

people around the world through computers.

We can use this service free of cost by registering with

one of the e-mail service provider to get our e-mail

account. There are many service providers who gives

this service to users like rediffmail, gmail, yahoo,

hotmail, etc.

2. Write the steps in creating G-mail ?

A. Step 1 : First things first, you need to head over to

gmail.com.

Step 2 : Click on the button that says "Create Account."

Step 3 : After that, the sign-up form will appear. You'll

need to fill in all the details it requests: first name, last

name, a new username, and a new password.

Step 4 : Next, you'll be asked to enter a phone number

to verify your account.

This is because Google uses a two-step verification

process to boost security. You can find out more about

two-step verification here.
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Step 5 : You should now receive a text message with a

verification code from Google. If this hasn't been

delivered within a few minutes, you can use the

automated call system instead.

Step 6 : Once you've verified your account, you will

see a form that asks for some personal information. This

includes a recovery email, your birthday, and your

gender. If you're not comfortable giving these or want

to find out why Google is asking for this information,

there is plenty of informationon offer during the sign

up.

Step 7 : You now need to accept Google's Terms of

Service and their Privacy Policy It's highly

recommended that you review both of these in detail

before clicking on "I Agree."

Step 8 : You should now have your new Gmail account.

3. Write about sign in and sign out ?

A. To sign inYou need to go to www.gmail.com. Type your

username and password, and then click 'Sign in'. Your

mail account has following components in it.To sign

out your Gmail account, in the top-right corner of the

page, click on email address and select Sign out.

4. Write the steps in writing on G-mail ?

Z Enter the e-mail address of the receiver in the To box.

Z Enter the subject of your mail in the subject line.
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Z Type your message in the big empty box then click on

Send button.

Z You can also attach your photos, documents or other

files as an attachment with the message.

II. Fill in the blanks.

1. Inbox 2.Compose 3. Logout 4. Action

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. T 2. F 3. T 4. T 5. F

2. Introduction to PowerPoint 2010

I. Answer the following questions.

1. Write the Steps to open PowerPoint

Z Click on the Start button.

Z Click on All Programs.

Z Select Microsoft Office.

Z Click on Microsoft Office Power Point 2010.

2. Draw the PowerPoint screen neatly and mention its

parts.

A. Do it by your own idea

3. Write short notes about the ribbon in the PowerPoint

screen.

A. The ribbon is the panel at the top portion of the

document. It has nine tabs: File, Home, Insert, Design,

Transitions, Animations, Slide Show, Review and View.

Each tab is divided into groups.

4. Where is the title bar in the PowerPoint screen ?
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A. The Title bar is located at the top of the screen.

5. What is slide and presentation ?

A. Slide: slide is an empty rectangular area where the data

and drawings are to be entered. Presentation: it is a

collection of several slides with colorful text, sound and

pictures.

II. Fill in the blanks.

1. Presentation 4. The Slide

2. Top 5. Presentation

3. Below

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3.T 4. T

IV. Match the following.

1. C 2. B 3.D 4. A

3. Creating, opening and saving files

I. Answer the following questions.

1. Write the Steps to Create a New (Blank) Presentation.

Z Click at File tab.

Z Click at New.

Z Click at Blank presentation.

Z Click on the Create button.

2. Write the steps to open an existing presentation.

A. To Open Already saved Presentation follow these steps.

Z Click on the File tab then click on Open.
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Z Select the presentation.

Z Click Open.

3. Write the steps to save a PowerPoint slide as a JPG

picture.

A. The Save command is used to save the presentation in

the current name and in the warrent location. The Ctrl +

S key combinations is used to save a file.

4. Write the steps to close the document in PowerPoint.

A. A File can be closed by clicking on File tab and then

selecting Close. If any attempt made to close an unsaved

file PowerPoint prompts to save the unsaved file.

5. What is the difference between Save and Save As ?

A. Save command is used to save the presentation in the

current name. Save as is used to make a second copy of

the original file.

II. Fill in the blanks.

1. File 2. Ctrl+N 3.Powerpoint

4. Exit/close 5. .pptx

III. Match the following.

1. B 2. C 3.D 4.E 5. A

4. Slide layouts

I. Answer the following questions.

1. In how many ways the slide layouts are grouped ?

A. The slide layouts are grouped as

Z Title slide
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Z Title only

Z Title and content

Z Blank

Z Section header

Z Content with Caption

Z Two Content

Z Picture with caption

Z Comparison

2. Write about title slide ?

A. This layout contains space for a title and a subtitle. To

select this layout, click on the title slide layout from

layout command button of the home tab

3. Write in steps how to add text in slides ?

Z Click Inside the place holder and type the desired text.

Z Click in a blank space just outside the edge of the slide

to deselect the text box.The hatched lines and resize

handles disappear.

Z With the insertion point at the end of a bulleted item,

you can create additional bulleted items by pressing the

Enter key.

4. Write in detail how to add a text box ?

A. From the Insert tab, click the Text Box command

Yourcursor will turn into an upside-down cross. Click

the area on your slide where you want to add a text box.

A text box will appear with an insertion point inside.

5. Write about deleting slide text?
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A. Select the text you want to delete and press the delete

key

6. Write about editing slide text ?

A. Select the Text to be copied. Press Ctrl+C or click on

the Copy icon in the Clipboard group of the Home tab.

Select the Text to be cut. Press Ctrl+X or click on the

Cut icon in the Clipboard group of the Home tab.

II. Fill in the blanks.

1. Backspace 4. Ctrl+Z

2. Delete 5. Home

3. Ctrl + Backspace

III. Match the following.

1. C 2. E 3. A 4. B 5. D

5. Inserting pictures and drawings

I. Answer the following questions.

1. How can be the slides look more attractive?

A. To make the presentation more attractive and effective,

the slides in PowerPoint should be designed with

drawings and pictures as necessary.The PowerPoint

Package comes with a rich set of drawing tools in the

drawing toolbar.

2. Write the steps to insert a picture in your slide using the

ribbon.

Z Select the Insert tab.

Z Click the Picture button in the Images group. The Insert

Picture dialog box will appear.
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Z Locate and select the picture you want to use.

Z Click Insert and it will appear on the slide.

3. Write the steps to resize a picture.

Z Select the picture.

Z Click one of the corner sizing handles.

Z The cursor will turn into a cross.

Z While holding down the mouse button, drag the sizing

handle until the image is of the desired size.

Z Release the mouse button. The side sizing handles

change the picture's size, but don't keep the same

proportions

4. Write the steps to move a picture from one place to

another in the same slide.

Z Click the picture. Your cursor becomes a cross with

arrows on each end.

Z While holding the mouse button, drag the image to the

desired location on the page. Release the mouse button.

Z The green circle is the Free Rotate feature. Click and

hold the mouse button and rotate the picture in various

directions.

5. Write in detail about how to insert media clip ?

A. A Media Clip is a movie clip which displays part of a

movie. Click on the icon Insert Media Clip, the Insert

Movie dialog box appears. Choose the required motion

clip or audio file and click on OK button to insert the

clip on the slide
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6. What do you know about viewing a presentation ?

A. Viewing a presentation is technically called as running

a slideshow. A slide show always runs on full screen

view. To view the presentation, choose any one of the

following methods.

Z Click on View tab of the ribbon and then in Presentation

Views group click on Slide Show button.

Z Click on Slide Show tab of the ribbon and then in Start

Slide Show group choose From Beginning.

II. Fill in the blanks.

1. Drawing 4. Delete

2. Images 5. Format

3. Insert

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. F 3. T 4. F 5. F 6. F

II. Match the following.

1. B 2. D 3. E 4. C 5. A

6. Inserting word art, shapes and smart art

I. Answer the following questions.

1. What is the use of Word Art ?

A. Word art is a gallery of text styles.It is used to add

decorative effects to the text.

2. Write the steps to insert Word Art in PowerPoint.

A. On the Insert tab, in the Text group, click WordArt, and

then click the WordArt style that you want. Enter your text.
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3. Write the steps to convert existing text into word art.

A. Select the text that you want to convert to WordArt. On

the Insert tab, in the Text group, click WordArt, and

then click the WordArt that you want.

4. What are the steps to be followed to change the fill

colorof a word art ?

A. Select the text you wish to modify. Click the Text Fill

command in the WordArt Styles group. Move your

cursor over a color option to see a live preview on the

slide. Click a color to select it.

5. Write the steps to change the text outline of a Word Art

style.

Z Select the text you wish to modify. The format tab will

appear.

Z Select the Format tab.

Z Click the Text Effects command. A menu of options will

appear.

Z Select a menu option. The options are: Shadows,

Reflection, Glow, Bevel, and transform. This will

display a sub menu.

Z Click an option from the sub menu to select it.

6. How can you insert a shape into a slide?

Z Click the Shapes button under Illustrations group of the

Insert tab.

Z Move your cursor toward the slide. It will appear as a

cross shape.
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Z Click and hold down the mouse button, and drag the

cursor until the shape gets the desired size.

Z Release the mouse button to insert the shape.

II. Fill in the blanks.

1. Text 4. four

2. Many 5. Arrange

3. Illustrations

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. F 3. F 4. T 5. F

7. Charts and Tables

I. Answer the following questions.

1. What is the use of a chart in PowerPoint ?

A. A chart is a tool you can use to represent your data

graphically. Charts often help to see the meaning behind

numbers and make showing comparisons and trends

easy.

2. How can you insert a chart into a slide ?

Z Select the Insert tab.

Z Click the Chart button on the Illustrations group. The

Insert Chart dialog box appears.

Z Click and drag the scroll bar to view the chart types, or

click a label on the left of the dialog box to see a specific

chart style.

Z Click a chart to select it.

3. Write the steps to enter data in a chart ?
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Z Select a cell in the Excel spreadsheet.

Z Enter your data  in the cell. If the cell contains

placeholder data, the placeholder data will disappear.

As you enter your data, it will appear in the Excel

spreadsheet and the PowerPoint chart.

Z Move to another cell.

Z Repeat the above steps until all your data is entered.

4. Write the steps to change the chart type ?

Z Select the chart.

Z Select the Design tab.

Z Click the Change Chart Type button on the Type group.

The Insert Chart dialog box will appear.

Z Select the chart you would like.

Z Click OK. The chart will change on the slide to the new

chart type.

5. How can you edit the source data of a chart ?

Z Select the chart.

Z Select the Design tab.

Z Click the Edit Data button on the Data group. An Excel

spreadsheet with the current source data will appear.

Z Edit the data in the spreadsheet. The changes will appear

on the slide.

6. Write about how to insert a table ?

A. By double clicking on the table icon, the Insert Table

dialog box appears. The number of rows and columns

can be specified followed by OK button. The slide now
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contains a table with specified number of rows and

columns where text can be inserted.

II. Fill in the blanks.

1. Chart 4. Three

2. Illustrations 5. Design

3. Different

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3. F 4. F 5. F

8. Animating and slide show

I. Answer the following questions.

1. Write the steps To Apply a Default Animation Effect to

an object.

PowerPoint offers a variety of animations to enhance

your presentation. Animations can be used to make text

or objects appear on a slide, exit from a slide, or

emphasize the text or objects already on a slide.

2. Write the steps To Apply a custom Animation Effect to

an object.

Z Select an object.

Z Click the Animations tab.

Z In the Animation group, click the more drop-down arrow

to view the available animations.

Z Select the desired animation effect.
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Z The object will now have a small number next to it to

show that it has an animation. Also, in the Slide pane,

the slide will now have a star

Z At the bottom of the menu, you can access even more

effects.

3. How can you see the preview of an animation effect?

Z Navigate to the slide you want to preview.

Z From the Animations tab, click the Preview command.

The animations for the current slide will play.

4. Write the steps to insert a sound file into a slide.

A. A sound can also be inserted from an existing sound

file by clicking on Insert tab, Click on Sound button

and choose the option Sound from File. Now select the

name of the file and click on OK button to insert the

sound in a slide.

5. Write the steps to preview a movie in your presentation.

Z Go to the Media group under the Insert ribbon.

Z To insert video file select video as media type and video

from file to insert an video from your computer hard drive

Z In the insert video dialog, browse for a video file and

click insert.

Z Video file is added to the slide

II. Fill in the blanks.

1. Animation 4. Top

2. Animation 5. Insert

3. Animation
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III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. T 2. T 3. F 4. F 5. T

IV. Match the following.

1. B 2. D 3. A 4. C

9. Viewing and printing slides
I. Answer the following questions.

1. Explain the options for printing a presentation.

Z Go to the Print pane.

Z Determine and choose how you want the slides to appear

on the page.

Z If you only want to print certain slides, you can type a

range of slides. Otherwise, select Print All Slides.

Z Select the number of copies.

Z Select a printer from the drop-down list.

Z Click the Print button.

2. Write the steps to pack a presentation for CD.

A. To package a presentation for CD:

Z Click on Save & Send on the File tab.

Z Click Package presentation for CD..

Z Click Package for CD button.

Z Type a name for the CD.

Z Click Copy to CD or Copy to Folder

3. Write the steps to see the print preview of a presentation.

A. Click the File tab Select Print. The Print pane appears, with

the print settings on the left and the Preview on the right.

4. How can you create speaker notes ?
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A. To add speaker

Z Select the slide.

Z Select notes option at the bottom of the screen and add

the notes you want.

5. Write short notes on slide show view.

A. This view fills the computer screen with a slide and

iswhat the audience will see when they view the

presentation. The slide show view has an additional

menu that allows you to navigate through the slides, as

well as other features you can use during a presentation.

6. Write short notes on Slide sorter view.

A. Miniature slides are arranged on the screen in this view.

You can drag and drop slides easily to reorder them,

and you can see more slides at one time.

II. Fill in the blanks.

1. Bottam right side window 4. Slide show

2. Normal view 5. Four

3. Slide sorter view

III. Write true (T) for a correct statement and false (F) for

an incorrect statement

1. F 2. T 3.T 4.F 5. F

IV. Match the following.

1. B 2. C 3.D 4.E 5. A

10. Introduction to Qbasic

I. Answer the following questions.

1. What is Q-Basic and write the components of Q-Basic

Window.
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A. Beginners All-purpose symbolic instruction code is a

beginners high level programming language. It is very

easy and simple programming language.

Z Title bar :It shows name of application.

Z Menu bar : It provides various options to run the

commands.

Z Untitled : Name of the current program.

Z Work area : It is the main area where the computer

program is entered by aprogrammer.

Z Status : It shows the status of instruction , whether it is

correct or not.

Z Scroll bar : It is used to move up and down in Qbasic

window, when the program cannot be displayed on a

single screen.

2. Explain about Q-Basic Statements.

Z CLS : CLS stands for Clear screen, It is used to clear

the screen. It is generally used as first line in a Qbasic

program.

Z PRINT Statement : It is used to display result on the

screen.

Z REM Statement : It is used to write commands in a

program

Z END Statement : It indicate the end of the program .If

any statements written after END will not be executed.

3. Explain about different types of operators.
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A. Operators are used to perform various operations on

constants or variables. These are the types of operators:

Z Arithmetic Operators : These are used to perform

mathematical calculations.

Z Relational Operators : Relational operators are used

compare two values

Z Logical Operators : These operators are used to combine

two or more relational expressions to calculate a single

value as true or false.

4. Define LET and Input statements

A. LET statement is used to assign a value to a varaible. It

is also known as assignment statement.

Input Statement is used to take value during the

execution of the program.

5. Write the difference between Constants and Variables.

A. Constants: Constants are the values in a program, which

does not change during the execution of a program.

Variable : A variable is a name given to memory space

where we are storing data. The value of a variable can

change during the program execution.

II. Fill in the blanks.

1. Q basic statement 4. LET

2. Interpreter 5. Operators

3. REM statement 6. Logical operators

III. Write true (T) for a correct statement and false (F) for

an incorrect statement
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1. T 2. T 3. T 4. T 5. T

6. F 7. T

11. Statements in Q Basic

I. Answer the following questions.

1. What are the conditional statements ? Name them.

A. In Q Basic, while writing the program some of the

commands are executed based upon the satisfaction of

the condition.. The condition executes and result is a

True or False.The conditional statements used in Q basic

are

1. IF….. Then 3. IF……Then ...... Else If

2. IF…… Then Else 4. Select case

2. Write a short notes on IF...THEN...ELSE condition.

A. IF……Then…...Else is a conditional decision making

statements. IF command is used for executing a

statement based on a certain condition. If the condition

written next to IF is TRUE then the statement part will

be executed. If the condition is false then the statement

after the ELSE part will be executed.

3. What are Looping Statements and name them ?

A. A loop is used to repeat a set of statements more than

once based on a certain condition. The statement is to

be executed repeatedly until the condition is fulfilled.

QBASIC offers the following loops.

1. FOR………NEXT 3. DO WHILE……….LOOP

2. DO……..LOOP 4. DO UNTIL………LOOP
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4. Write a short notes on DO.. LOOP statement and write

types of DO...LOOP statement.

A. A DO……………LOOP repeats the statements

depending upon the given condition. It means that the

statements written with in DO…..LOOP will be repeated

till this condition is true. DO….LOOP generally

preferred when the number of iterations are not known

types are Do..While loop, Do..Untill…loop.

II. Fill in the blanks.

1. Qbasic 2. Q basic statement 3. IF then else

4. IF then else if 5.loop

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. T 2. F 3. T 4. T 5. T

12. Graphics & Sounds in Q Basic

I. Answer the following questions.

1. Give short notes to draw lines using directions and

diagonals.

A. There are four types of diagonal statements, which are

used to draw lines in different direction diagonally.

Z E - Draw a line diagonally in upward direction towards

the right side.

Z F - Draw a line diagonally in downward direction

towards the right side.

Z G - Draw a line diagonally in downward direction

towards the left side.
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Z H - Draw a line diagonally in upward direction towards

the left side.

2. Explain line and circle command.

A. The Line can be drawn in any direction using the

particular characters,Thereare four directions to draw

line.

Z D - Downward direction of the line.

Z U - Upward direction of the line.

Z R - Right direction of the line.

Z L - Left direction of the line.

Circle command is used to draw circle arc (or) ellipse

in Qbasic.

3. Define Color command.

A. COLOR command is used to change the Color of the

screen and the text.

Q Basic uses Color codes (numbers) for different colors.

To select any specific Coloryou need to mention the

correct Color numbers.

Syntax : COLOR (number) where the number ranges

from 0 to 15 for a specific Color.

4. Write color codes and their names of QBASIC.
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Colour Code Colour Name Colour Code Colour Name

0 Black 8 Grey

1 Blue 9 Light Blue

2 Green 10 Light Green

3 Cyan 11 Light Cyan

4 Red 12 Light Red

5 Magenta 13 Light Magenta

6 Yellow 14 Light Yellow

7 White 15 White

5. Write a note on sound command.

A. The SOUND f, d command is used to specify the BEEP

intensity, i.e. how high or low the beep sound will be

and the time for which the sound will be heard.

Z f stands for the frequency, which can be from 37 to

32,767Hz.

Z d stands for duration for which the sound plays (it can

range between 0 and 65535)

II. Fill in the blanks.

1. color 2.text mode and Graphic mode. 3.circle

4.line 5.0 to 15

III. Write true (T) for a correct statement and false (F) for

an incorrect statement.

1. F 2. T 3. F 4. F 5. T
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Computer Level 8

1. Computer Networking

I. Answer the following questions.

1. What is a computer network ?

A. Computer networks refer to interconnected computing

devices that can exchange data and share resources.

These networked devices use a system of rules called

communication protocols to transmit information via

physical or wireless technologies.The goal of a computer

network is to share resources among different devices.

2. What are the advantages and disadvantages of a

computer network ?

Computers in a network have the following advantages:

Z Cost-effective, as the resource can be used by multiple

people.

Z Software licenses are likely to be cheaper than buying

multiple individual licenses

Z Time saving when sharing files.

Computers on a network have the following

disadvantages:

Z Managing a large network is complicated, requires

training, and requires a network.

Z If the file server malfunctions, users may not be able to

run applications. Work then comes to a halt.

Z Purchasing network cabling and file servers can be

expensive.
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Z If there is a problem in a network, then all computers

connected to the network cannot be used.

3. What is the difference between a switch and a hub ?

A. Hub

A hub is a network device that contains multiple ports

to connect other devices. It serves as a central connection

point.

Switch

A switch is a special form of a hub. Unlike anordinary

hub, a switch transmits data to only one or more ports

on a network that need to receive it.

4. Describe the different types of network cables.

A. Network Cables

Twisted pair cables and coaxial cables are commonly

used to establish network.

Twisted pair cable

It contains 8 wires, commonly used in telephone lines.

These are connected through RJ 45 connector.

Co-axial cable

These cables are used to connect network device like

modem, router and adaptors etc.

Fiber optical cable

These cables are transmitting light instead on electrical

signals. Its common used to transmit large amount of

data to long distance.

5. Describe the different types of networks.

A. Type  of network are:
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Z PAN

Z LAN

Z MAN

Z WAN

Z INTRANET

Z INTERNET AND

Z NETWORK TOPOLOGIES

II. Fill in the blanks with the given hints.

1. Personal area network

2. Computer networking

3. Node

4. Bridge

5. Repeater

6. Optical fibre

2. Data base management system

I. Answer the following questions.

1. What is a database ?

A. A database is a collection of data or information. This

information is organized in such a way that the computer

program can quickly retrieve the data youwant.Itcan be

easily accessed, managed and updated.

2. What are the advantages and disadvantages of DBMS?

Advantages of DBMS

Z Database stores huge amount of data.

Z Database facilitates quick and easy management and

storing of data.
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Z It allows us to share and collect data in effective manner.

Z Database will manage centrally. This controls

inconsistency and duplication of data.

Dis advantages of DBMS

Z Some applications of DBMS are very slow.

Z It is expensive and occupies a large storage space in

hard disk.

Z DBMS is very complex to understand

3. Explain the terms flat file and relational database.

A. Flat File Database : It is a type of database that contains

records having small number of fields without any

structured relationship between them. The most popular

example of flat file database is

Relational Database : It is a type of database that stores

datain several tables and links those tables together to

get a commonpiece of information. This type of database

system is called Relational Database Management

System (RDBMS). Commonly used relational database

systems are MS Access, Microsoft SQL Server,

ORACLE, etc.

4. What are database objects ?

A. MS-Access allows you to create objects. The various

database objects are :

Z Tables

Z Forms

Z Primary key
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Z Reports

Z Queries

II. Fill in the blanks with the given hints.

1. Table 2. Primarykey 3. Forms 4. Reports

3. Introduction to MS Access 2010

I. Answer the following questions.

1. What is MS access ?

A. Microsoft Access 2010 is commonly used as a DBMS

application on Windows based computer systems.It is a

database management system from Microsoft that

combines the relational Access Database Engine with a

graphical user interface and software-development

tools.

2. Explain any three features of MS Access.

A. Some of the important features of MS Access are:

Z It is easy to use and an ideal application for individual

users and smaller teams.

Z It allows to import and export to other Microsoft Office

and other applications.

Z It provides templates for regular users to create and

publish database.

Z It reduces data redundancy.

Z It allows to generate and format printable reports.

3. Write the names of three data types of MS Access.
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A. Text :To store text or numbers that does not require any

calculations. For example, mobile numbers, name. It

stores up to 255 characters.

Number : To store numbers which require calculations

except those involving money (i.e. currency).

Date/Time : To store date and time.

4. What is primary key ?

A. A Primary key is a unique entry to each record. It is

defined as the field for which all the records have a

different entry. For example, admission number, Roll

Number, Phone Number and so on.

5. Write in steps how to add a table in Datasheet view.

A. Step 1 : Open the blank database window. By default,

Access names the first field as ID.

Step 2 : Click Click to Add column. Change field names

to all the new fields to specify the type of data stored in

each field. If you do not enter the Field names, F, Field

2, Field 3 and so on are taken by default.

Step 3 : Enter the data under the name of each field. MS

Access takes the data type automatically, based on the

field name given.

6. What are the rules for naming the fields ?

A. Follow the rules while naming a field in a table.

Z The field name should not be more than 64 characters.

Z The field name can include lowercase, uppercase or

mixed case letters, numbers and an underscore.
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Z It cannot have a period(.), exclamation mark (!), or

square brackets ([ ])

Z It cannot start with a blank space.

7. Write in steps to change the data type of a field.

A. Step 1 : On the Home tab, in the Views group, click

Design View.

Step 2 : Select the field to change thedata type and select

the new data type from Data Type column.

Step 3 : Choose the desired field properties.

Step 4 : Save the table.

8. Explain the types of views in a database.

A. There are two types of views in MS Access: Datasheet

view and Design view. We can switch between these

two views by clicking on the View command under the

Views group on the Home tab. We can also use the

Design View and Datasheet View buttons located on

the right-hand side of the Status bar to switch between

two views.

II. Fill in the blanks with the given hints.

1. Navigation 2. Datasheet 3. Design

4. Fieldgrid 5. accdb 6. ribbon

III. State true or false.

1. T 2. T 3. T 4. T 5. T

6. T 7. F
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4. Tables in MS Access 2010

I. Answer the following questions.

1. What do you mean by freezing a column?

A. Freezing means to make one or more columns to be

visible all times while scrolling in any direction. When

you freeze a column in a table, the column will move to

the leftmost side.

2. How many rows can we add in a table?

A. We can add unlimited rows in a table.

3. Which command is used to delete the records from a

table ?

A. To delete a record, follow these steps:

Step 1 : Open the required table in Datasheet view.

Step 2 : Select the record which you want to delete.

Step 3 : Right-click and select the Delete Record option.

4. Write the steps to freeze a column in a table.

A.Follow these steps to freeze a column:

Step 1: Right-click on the column header that you want

to freeze. The context menu appears.

Step 2 : Select the Freeze fields option from the context

menu. The selected column will freeze and move to the

left most side.

5. Write the steps to add a new column in a table.

A. Step 1:Open the table in which you want to add a

column.
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Step 2 : Column header on the left of which you want

to add a column.

Step 3 : Click on the type of field which you want to

add in your table under the Add & Delete group of the

Fields tab.

6. Write about handling records in a table.

A. MS Access facilitates you to add, delete, edit and sort

records in a table.

7. How can we delete a column in a table ? Explain in

steps.

A. Follow the steps to delete a column from a table

Step 1 : Select the column which you want to delete.

Step 2 : Click on the Delete command under the Add &

Delete group of the Fields tab. The Microsoft Access

dialog box appears.

Step 3 : Click on the Yes button. The selected column

will be deleted from the table.

II. Fill in the blanks with the given hints.

1. Hide fields 2. Navigation 3. Field properties

4. Blue-colour 5. Shift 6. Description

III. State true or false.

1. T 1. T 1.T 1.T 1.F

III. Choose the correct answer.

1. A 2.A 3.A 4.A
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5. Queries in MS Access

I. Answer the following questions.

1. What is query ? What are its types ?

A. Query : A query is a database object used to retrieve

specific information from the database. Its types are

1. Select query 2. Sort query 3. Summer query

4. Parameter query 5. Auto lookup query

6. Action query 7. Cross tab query

2. Write in steps how to create a relationship between the

tables.

A. To create a relationship between the two tables, follow

the steps:

Step 1 : Open table Student Record (or Student Marks).

Step 2 : On Database Tools tab, in the Relationships

group, click the Relationships option. The Show Table

dialog box appears.

Step 3 : Double-click the two tables that appear in the

dialog box. These tables will now appear under a new

tab called Relationships.

Step 4: Click the Close button of the Show Table dialog

box to close it.

Step 5 : Drag and drop the common field of one table

on the common field of the other table. This will create

a relationship between the two tables.

3. What is foreign key and primary key ?
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A. Primary Key which uniquely identifies each record in a

table. A Foreign key is the Primary key of another table

which creates a link between two tables basing on a

common column.

4. What are the steps involved in creating a foreign key ?

Step 1 : Close all the tables in thedatabase.

Step 2 : On the Database Tools, in the Relationship

group, click Relationships.

Step 3 : The Show Table dialog box appears. Edit

relationships dialog box Relationship between the two

tables Relationships option

Step 4 : Select a table and click the Add button. The

table is added in the background. Similarly, add the other

tables.

5. Write in steps, how we create a query using query

wizard.

A. On the Create tab, in the

Step 1 : Queries group, click the Query Design option.

Query Design option Show Table dialog box appears.

Step 2 : Click Student Marks table and then click Add

button. Then click Close button. Student Marks pane

will appear hanging under the Query1 tab.

Step 3 : Double-click the Field names : Subject Marks

and ID. These will be added to the bottom pane of the

Query Design window.
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II. Fill in the blanks with the given hints.

1. Select  Query 2. Action Query 3. Query Design

4. Query 5. Foreign key

6. Forms and Reports in MS Access

I. Answer the following questions.

1. What is a form? What are the various views of a form ?

A. Form is a representation of data in a table in an easy-to-

understand format. A form allows you to view, enter,

modify or delete data on one record at a time in a table.

The various views are form view, Design view and

Layout view.

2. Write the steps to create forms.

A. Step1 : Select the table for which you want to create a

form. say, Student Record.

Step 2 : On the Create tab in the Forms group, click

Form option.A Form for Student Record appears.

Step 3 : When you click on the individual fields an

orange outline appears around that field.

Step 4 : You can also edit the design of the Form by

dragging different items within the dotted placeholder.

Step 5 : You can use your designed form to enter data.

3. How do we create forms using Form Wizard ?

A. Step 1 : On the Create tab, in the Forms group, select

Form Wizard. The Form Wizard dialog box appears.

Step 2 : Select the table from the Tables/Queries drop-

down list box.
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Step 3 : Click the Add All button to select all the fields

under the Selected Fields list.

Step 4 : Click the Next button.

Step 5 : Select the desired layout from the options and

click the Next button.

Step 6 : Enter the form name in the text box.

Step 7 : Click the Finish button.

4. How do we create reports using report Wizard ?

A. On the Create tab, in the Reports group, select Report

Wizard.

Step 2 : The Report Wizard dialog box appears.

Step 3 : Select the table from the Tables/ Queries drop-

down list box. Click Next.

Step 4 : Click the Add All [>>] button to shift all the

fields appear under the Selected Fields list box.

II. Fill in the blanks with the given hints.

1. Design 2. Create 3. Form 4. Report 5. Query

7. Introduction to adobe Photoshop

I. Answer the following Questions

1. Whatare the various Lasso tools available in photoshop?

Z Lasso Tool: It is used to make freeform selection.

Z Polygonal Lasso Tool : It is used to select polygonal

areas.

Z Magnetic Lasso Tool : It identifies an image's edges

and automatically selects the image.
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2. What is the use of drawing tools available in photoshop ?

A. To draw a shape, say a rectangle with rounded corners,

follow the steps given below:

Z In the Tools panel, select the Rectangle tool.

Z Click and hold the left mouse button on the small black

triangle at the bottom right corner of the Rectangle tool.

Z Select Rounded Rectangle Tool from the menu that

appears.

3. What is the function of magic wand tool ?

A. Magic Wand Tool: The Magic Wand tool is used to select

areas with the same color in an image. The steps to do

this are as follows:

Z Open an image in Photoshop.

Z Click on the Magic Wand tool from the Tools panel.

The shape of the mouse pointer will change.

4. Can you draw shapes other than the basic geometric

shapes? If yes, write the steps ?

A. You can draw shapes other than the basic geometric

shapes using the Custom Shape tool .The steps to do so

are as follow,

Z In the Tools panel, select the Custom shape tool

Z In the Options be click on the arrow next to the Shape

option. Select the required

Z Click and drag the left mouse button to draw the shape.

5. Write the steps to use the crop tool ?
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A. Follow the steps given below to crop an image

Z Open an existing image as explained earlier.

Z Click on the Crop tool.

Z Click and drag to select the portion of the image you

want to crop.

Z Double-click inside the cropping boundary or press

Enter key.

6. Write about flipping and rotating ?

A. Flipping means making a mirror image of the selected

portion of the image. You can also rotate the selected

part by any angle. Then various steps to flip/rotate a

portion of your image are listed below

Z Open an existing image as explained earlier.

Z Select a portion of your image using a Selection tool.

Z Select Transform option from the Edit menu.

Z To flip the selection, choose Flip Horizontal or Flip

Z Vertical option. To rotate the selection, choose Rotate,

Rotate 180°, Rotate 90° CW or Rotate 90° CCW option.

7. Write about manipulating windows?

A. You can manipulate a selected part of an image in the

following ways.

Z Move to Other Location

Z Flip and Rotate

Z Copy and Paste

Z Crop the Image
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II. Fill in the blanks.

1. Image title bar

2. .psd

3. Shift+L

4. Ctrl+C

5. Ctrl+Shift+S

III. Write T for True or F for False.

1. T 2. F 3. F 4. T 5. T

IV. Match the following.

1. E 1. D 1. B 1. A 1. C

8. More tools in Photoshop

I. Answer the following Questions

1. What are layers ? What is flattening of layers ?

A. Layers are one of the most powerful features of

Photoshop. They are like sheets of paper that are stacked

on top of one another.

Flattening the layers reduces the size of the file by

combining all the visible.layers into the background. If

any area is left transparent, it is filled with white colour.

To flatten the layers, click on Layer->Flatten Image.

2. What is the use of Healing Brush tool ?

A. The Healing Brush tool allows you to remove scars and

correct flaws. It uses sampled pixels or pattern to heal

an image causing the imperfections to disappear into

the surrounding image.

3. How will you merge layers in Photoshop ?
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A. If the layer 1 and Layer 5 are to be merged, then Layer

1 needs to be positioned above the layer 5 or layer 5

must be above the layer Now, of the two layers, click

on the top layer. Select the Layer tab and click on the

Merge down option. The top layer will be merged into

the bottom one. To merge all the visible layers, click on

the Merge Visible option in the Layers tab.

4. What are filters? How do you apply filters ?

A. Filters are used to apply special effects to an image in

Photoshop.

Applying a Filter

The steps to apply a filter are as follows:

Select a layer, if you want to apply a filter to an entire

layer. To apply a filter to a part of an image, select that

area using any of the selection tools.

Z Click on the Filter menu and select a filter.

Z In the dialog box that appears, select the values. In some

of the filters, no dialog box will appear. The filter is

applied directly.

5. What is the Dodge tool ?

A. The Dodge tool is used to lighten the areas on an image.

This tool is based on a traditional darkroom technique

for regulating exposure on specific areas of a print.
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II. Fill in the blanks.

1. Clone stamp

2. Rename

3. Move

4. Shift

5. Shift

III. Write T for True or F for False.

1. F 2. F 3. T 4. T 5. F

IV. Who am I ?

1. Dodge tool

2. Background layer

3. Filter

4. Clone stamptool

5. Spot healing tool
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C Language and HTML

1. Program and Programming

I. Answer the following Questions

1. What is programming?

A. The process of writing instructions or commands in a

particular computer language is called programming.

2. Who is a programmer ?

A. Those persons who specialize in computer programs

are called programmers.

3. Why programming is comparatively easier today than

a few years ago ?

A. Today programmers write instructions and commands

in different computer languages and then they are

converted into machine language. Therefore

programming is not so difficult today.

4. What is a system program? Give example?

A. System program is that which performs the operation

of the computer system itself. DOS (Disk Operating

System), UNIX are examples of system programs.

5. What is an application program? Give example?

A. Application programs are those programs specially

designed for particular kind of works. Examples of

Application Programs are :Foxpro, Ms-excel, Visual

Basic.

II. Fill in the blanks.

1. Windows
CYBERWAVE 147 C Lamguage & HTML



2. FoxPro, MS-excel, Visual Basic.

3. System Program

4. Application Program

5. Personal computer.

2. Algorithms and flowchart

I. Answer the following Questions

1. Define an Algorithm and a flowchart.

A. Preparing set of steps to solve a given problem is termed

as an 'Algorithm'. Basically it is step- by-step procedure

to solve a given problem.

A. flowchart is a pictorial representation of an algorithm.

A flowchart always helps us to understand the steps of

a plan easily. We have certain standard symbols in a

flowchart

2. Draw the symbols used in a flowchart.

A. The symbols of a Flowchart are

Oval Box Start/end Indicates start or end of the

flowchart.

Arrows Arrows A line is a connector that shows

relationships between the

representative shapes

Parallelogram Input/output Inputs data or outputs result.

Rectangle Box process shows an action Decision

Diamond Decision Indicates decisions taken.

Connector Connector to connect any two points of

flow chart
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3. Give two examples of planned activities.

Z To prepare coffee

Z To print the smallest of two number

4. Make a flowchart for going to school.

A. Support the student to do on its own

5. What do you understand by the term 'planing' ?is

planning required in our daily lives ?

A. Yes planning is required in our daily lives. Plan has

step-by-step procedure or instructions onhow to do a

Job. There should be clear instructions for the plan to

be completed successfully. Planning is required at every

stage of life. Our day to - Day activities should be

planned, otherwise we cannot achieve success.

II. Fill in the blanks with the suitable words.

1. Flowchart 4. Diamond/Decision

2. Arrows 5. Oval/End

3. Rectangle / process

3. Introduction to C

I. Answer the following Questions

1. When and where was C developed and by whom ?

A. C is one of the most popular and powerful programming

language widely used for software development. The

System programmer, Dennis] M.Ritchiedeveloped the

C language at& T Bell laboratories in this year 1972.

2. What is a Keyword ?
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A. The most important feature of 'C is that it uses only 32

keywords (or Reserved words whose meaning is already

explained in a broad sense).

3. Why is C language called as Middle - level language ?

A. Software developed in C can be System Software as

well as Application software and hence it is called as

Middle-1 Level Language.

4. How many keywords are there in C ? List them.

A. C keywords

auto case const else default Double

enum float goto int register extern

short sizeof Struct typedef unsigned for

volatile break char continue do If

long return static signed switch union

void while

5. Write down the Structure of C programming ?

A. Structure of 'C Programming

<header files> - (library files)

main () - A special function

{ - Open curly braces - a parameter

usually follows mainfunction.

declaring variables - Declaration of data types and

variables

Statement 1 - Input, Output and process

statements
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Statement 2} - Close curly braces - end of

aprogram.

In C program all the statements are terminated with a

semicolog (;) except in some statements.

6. Does C have date data type ?

A. No

7. How many characters can a variable name have ?

A. A variable name can have 31 characters.

8. Can comments extend beyond a single line?

A. Comments may appear anywhere in the program and

there can be any number of commentlines, only the

comment delimiters (/* */) must be placed in the

appropriate places.

9. What are Contrast Variable and Constant ?

A. A variable is a memory location in which we can store

data. The data can be changed and retrieved for

computation. Constants are data whose value does not

change throughout the execution of the program.

Normally the value, which is assigned to a variable, is

called as constant.

10. Write down the rules for naming a variable ?

A. Rules for naming variables:

It should begin with an alphabet.

The second and the succeeding character can be a

number or a letter.

No special characters are allowed except underscores (_).
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The maximum length of a variable name is 31 characters.

No reserved words or keywords are allowed in a variable

name.

11. What are the different types of data types ? List the

primary data types ?

A. The data types are classified as

Z Primary data type

Z Derived data type

Primary data types are

P Int

P char

P float

P double

12. Write any two Format Descriptors and Escape

Sequences ?

A. Control variable string meaning

% d integer

% f float

\n Newline character

/t Horizontal tabulator

13. Explain integer and character data type ?

A. There are four qualifiers of int data type. They are

Z Short int (nothing but an ordinary int)

Z long int

Z signed int

Z unsingnedint
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longint is used to store more than the usual range

(limitation) of Int Signed int is used to store both positive

and negative numbers whereas an unsigned int is usedto

store only positive numbers and this is declared forthe

variables that stores only positive numbers.

Char :The data type char is used to store any single

character. It has two Different qualifiers namely

Z signed

Z unsigned

14. What are header files ?

A. Header files, are built in C files, which contain the

declarations, and definitions of the most commonly used

Input Output functions. There are different header files

for different purposes like stdio.h (Standard Input

Output)for I/O functions,String.h for string

functions,Math.h for mathematical functions etc.

II. Fill in the blanks with the suitable words.

1. Semi colon

2. Standard input / output headerfile

3. built in files

4. 2

5. control variables

6. %s

4. Operators and I/O functions in C

I. Answer the following Questions

1. What is an operator ?
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A. Operators are those symbols that perform mathematical

and logical calculations. The different types of operators

are

Z Arithmetic operator

Z Relational operator

Z Logical operator

Z Increment and Decrement operator

Z Ternary operator

Z sizeof () operator etc.,

2. How many relational operators are there ? What are they ?

A. Relational operators

These operators are used to test the relationship between

two variables or between a variable and constant. The

relational operators are

> greater than

>= greater than or equal to

<  lesser than

<= lesser than or equal to

== equality (the variable or constant at right side is

extremely equal to that of the variable or constant at

left side)

!= not equal to

3. What is the difference between = and = =?

A. == equality (the variable or constant at right side is

extremely equal to that of the variable or constant at

left side)
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The "equal to" symbol (=) is called the assignment

operator. It assigns the variable or constant (expression)

on its right side to the variable.

4. Give the precedence of arithmetic and relational

operators.

A.

ARITHMETIC

OPERATOR PRIORITY

Bracket ( )

Exponentiation A

Division or Multiplication /or*

Modulus %

Subtraction or Addition - or +

RELATIONAL

OPERATOR PRIORITY

Lesser than <

Lesser than or equal to < =

Greater than >

Greater than or equal to >=

Equal to ==

Not equal to !=

5. What is the difference between pre-increment and

postincrement?

A. If the operator appear infront of the variable then it is

called pre-increment and if it appear at the end of

variable then it is called post-increment.
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6. What is the use of sizeof () operator ?

A. The size of () operator returns the number of bytes

occupied in the memory by an operand. The operand

may be a variable, a constant or a data type qualifier

(int.float, char etc.,)

7. Write equivalent but more concise statements for the

following

P p=p*q; =p*=q

P A=A+B; A+=B

P X=X%Y;  X%=Y

P S=S/X; S/=X

8. What is the difference between '&' and '&&' ?

A. & is an address of numerical value, && is an logical

operator

9. What command is used to print a string at a time ?

A. The puts( ) function works exactly opposite to gets ( )

function. It outputs a string on the screen. The general

form is Puts(variable)

10. What does '&' symbol represent in scanf("%d", &a); ?

A. In scanf ("%d",&a). Note that ampresad '&' symbol

refers to the address of the integer variable. This

isnecessary because the value typed through the

keyboard must be dropped into memory of the

corresponding variable.

11. What is the difference between gets() and putchar() ?

A. Putchar ( )
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In contrast to getchar ( ) function, this function is used

to print a single character on the screen. The general

form is putchar (variable);

Eg.,putchar(a);

gets( )

The gets() function is used to read a string along with

blank space The literal (string) is usually specified

within double quotes. The general form is gets(variable);

12. What statement should precede every scanf () function

& why ?

A. The name stands for "scan function" or "scan formatted".

This

function enables the user to enter values into a variable

during the execution of a program. They are used to

enter any combination of numerical values, character,

string etc.

The general form of scanf () function is:

scanf ("format descriptors", address of variables);

13. Write down the syntax of print() function ?

A. The Printf( ) function is an output statement used to

print out any message on screen or on a paper. The

Printf() stands for "print function" or "print formatted".

The general form of printf() function is

Printf ("escape sequences message");

Printf ("message control variables", variables);

14. What is the advantage of using gets() over scanf() ?
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A. The advantage of using gets ( ) over scanf ( ) is gets ( )

accepts string with spaces.

II. Fill in the blanks.

1. Relational 4. Boolean operator

2. decrement 5. &&

3. Modulus

III. Write T for True or F for False.

1. F 2. F 3. F 4. F 5. F

5. Program Execution

I. Answer the following Questions

Detect the Errors :

1. # include STDIO.h <stdio.h> is correct

main { }

(

printf ("Hello);

}

2. $ include stdio.h # symbol missing,<>

missing

main { }

{

chint; int should not be variable it is data

ch = 7 ; is missing

printf ("%f");

}

3. = includes stdio. # include<stdio.h>

main [ ]
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{

int P, Q ;

scanf("%d%d",&p,&q);missing

print("P and Q";) }

4. # INLUDE <STDIO.H>. #

include<stdio.h>

main ( )

character a;

a = '5'; %

c missing

printf ("%s",a);

Give the Output for the Following :

1. main( )

{

int x;

x=1;

x=2;

x=3;

printf("%d%d%d", x ,x,x);

}

output:3 3 3

2. main( )

{

intp ;

p = 4 * 5 % 5;

printf ("\np = %d", p);

} P=0
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6. Control structures

1. What is meant by Control Structure ?

A. Control structures refer to the order in which the

variousinstructions in a program are to be executed. In

otherwords, they determine the "Flow of control" in

aprogram.

2. What are the two types of Control Structure ?

A. C language supports two control flow structures namely,

Z Selection statements: if, if-else, Nested if, Switch

Z Iteration statements: While, Do-While, For

3. Write a brief note on three types of Control Structure ?

Z In Sequence Control Structure the statements will havea

normal flow of control. By default they are

executedsequentially one after another in the order in

which theyare placed.

Z Selection Control Structure allows decisionto be made

on a condition. Depending on the result ofthe condition,

program execution proceeds in onedirection to another.

Iterative

Z Control Structure permitsthe programmer to execute a

series of instructionsrepeatedly until a condition is

satisfied. It is also calledas Repetitive Control Structure.

4. Define Nested if loop ?

A. Nested if the if statement containing another if clauseand

the else clause is termed as Nested if statement.

5. Write down the syntax for Nested if loop?
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A. If (condition)

{

Statements;

If (condition)

{

Statements;

}

Statements;

{

Statements;

}

6. Write down the action of the switch statement?

A. A switch statement allows a variable to be tested for

equality against a list of values. Each value is called a

case and the variable being switched on is checked for

each switch case.

7. Mention the keywords used in the body of the switch

statement ?

A. Switch, case, break, default

8. What is the role played by a default statement in a switch ?

A. Default is similar to the last else in an if…else chain

andit is optional. If neither a case label matches nor a

defaultlabel is present, the statements within the switch

bodywill be skipped and the execution continues

thefollowing switch body.

9. What is the difference between if and switch statement ?

A . If statement:.
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if statement is control structure is used to check for

acondition that is true. Only when the condition is true,it

executes the statement following it.

Switch:A switch statement allows a variable to be tested

for equality against a list of values. Each value is called

a case and the variable being switched on is checked

for each switch case.

10. Write down the difference between pre and post

decrement ?

A. If the operator appear infront of the variable than it is

called pre decrement  ex:--I

if the operator appear at the end of the variable than it

is called pre decrement  ex:I--

11. What happens to the program if the while loop

isinitialized. false ?

A. The loop terminates and the print statement followingthe

while loop gets executed.

12. Contrast while and do ..... while loop ?

A. The major difference between while and do while loopis

while loop checks the condition and executes

thestatements wherein do ............. while loop executes

the statements at least once, before checking for the

condition.

14. What is the minimum number of times does a do ..While

gets executed ?

A. At least once.
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14. What is a Nested for loop ?

A. Nested for :

A body of one for loop containing anotherfor loop is

called Nested for loop.

15. Write the for loop syntax ?

A. The syntax of for loop is For (expression 1; expression2;

expression 3)

16. Write a note on for loop ?

A. A special advantage of for loop is that it contains

initialization, testing and modifier expressionswithin

asingle set of parenthesis. The general form if :

for(expression1; expression2; expressions)

17. What separates the expressions in a for loop ?

A. Semicolon (;)

18. Is it necessary to have all the three expressions in a

forloop ?

A. no

19. Write down the syntax for a while and do while ?

A. When the condition FALSE, loop terminates

immediately and continues the statement following the

while loop.

The general form is:

while (condition)

{

statements;

}
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II. Fill in the Blanks :

1. control structure

2. repetitive control structure

3. selection

4. switch case

5. initialising, testing and modification

6. if else if

7. Arrays and Functions

I. Answer the following Questions

1. What is an Array ? What are its types ?

A. An Array is a set of values arranged sequentially and

referred by a single variable. It is also defined as a

homogeneous data item as it is a collection of items

that are of same data type. Arrays are of three types.

They are

Z Single dimensional array

Z Double dimensional array

Z Multi-dimensional array

2. Write the syntax to declare an array ?

A. For example, a set of 5 different values can be stored in

a single variable x. Each element in the variable can be

positioned (indicated) by means of a Subscript of

IndexNumber.

x [ 0 ] = 4 3

x [ 1 ] = 3 2

x [ 2 ] = 5 7
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x [ 3 ] = 6 5

x [ 4 ] = 8 3

Note that an array subscript starts with zero.

3. What is automatically assigned to terminate a string

constant ?

A. The string constant in an array is terminated by a '/o' or

a null character.

4. Why do you use a gets () function ?

A. To accept a string with spaces we use gets() function.

5. What is a function and what are its types ?

A. Functions are self-contained program block used to do

a specific task. They are designed to carry out some

frequently used tasks, and called upon by its name when

required. Thefunction are of two types. They are

Z Library functions

Z User-defined functions

6. Mention the classifications of Library functions ?

A. Library Functions Library functions are built-in

functions in any programming language. C also has a

classification of library functions. They are classified

as

Z Mathematical functions

Z String functions

Z Time & Date functions

Z Standard Input/ output functions

Z Character class test functions etc.
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7. What is a user-defined function ?

A. User-Defined functions

As the name says these functions are defined by the

user and are written as a part of the program according

to the programmer's requirement. They can be called in

a program as many times as needed.

8. Contrast strcpy() and strcat() ?

A. String Concatenate

This function accepts two arguments separated by

commas. The function used is strcat( ). The general form

is :strcat(string1, string2) It helps to concatenate two

strings by combining string 2 to the end of stringl,

placing a null character at the end of the final string and

returns string 1"

String Copying

This function also accept two strings. It copies string2to

string1 returning string1. The function used to copyis

strcpty ( ).

The general form is :strcpy(string1, string2);

9. Name the header file included while performing a string

operation in a code

A. <string.h>

10. How does strcmp() function works ?

A. String Comparison

This function is used to compare two strings. The

function used is strcmp ( ). It checks for the characters
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in string 2 are exactly equal to the characters in string1.

If string 1 is equal to string2, it returns the integer value

zero. If string 1is less than string2 it returns the integer

value zero and if string1 is greater than string2 it returns

a number greater than zero.

The general form is: strcmp(string1, string2)

II. Fill in the Blanks:

1. Array

2. homogeneous data item

3. linear array

4. subscript of index number

5. zero

6. character array or string

7. null character

8. functions

9. string function

10. string comparison / strcmp()

8. Introduction to HTML

I. Answer the following Questions.

1. What is HTML?

A. HTML stands for Hyper Text Markup Language which

is used for creating web pages and web applications.

2. What are the characteristics of HTML?

Z It is a very easy and simple language. It can be easily

understood and modified.
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Z It is very easy to make an effective presentation with

HTML because it has a lot of formatting tags.

Z It is a markup language, so it provides a flexible way to

design web pages along with the text.

Z It facilitates the programmer to add Graphics, Videos,

and Sound to the web pages which makes it more

attractive and interactive.

Z HTML is a case-insensitive language, which means we

can use tags either in lower-case or upper-case

3. What are the requirements for creating a web page?

A. The tools required to create web page are :

1. HTML editor 2. Web browser

4. How many types of tags are there in HTML? What are

they ?

A. There are two types of tags in HTML

Z Container tags

Z Empty tags

Start tag End tag

<html> </html>

<body> </body>

<title> </title>

Container tags

Container tags are those tags that have a start and an

end tag. Examples of Container tags are follows.

Empty Tag
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Empty tags are those tags that do not require any end

tag. They have only a start tag. Examples of empty tags

are as follows:

<br> known as break tag and

<hr> known as horizontal ruler tag

The First tag is known as the opening tag or the ON

tag. The end tag is known as the closing, tag or the OFF

tag. It is preceded by a slash (/) between the angular

brackets. The main content is placed between the

opening and closing tags. <tagname> contact </

tagname>

5. What is the structure of HTML?

A. In designing a web page using HTML the body structure

consists of 2 parts the head and the body. The head

section contains information about the document such

as the document's title. The body of an HTML document

contains all the information you desire to display on

the web page. The Information includes text, graphics,

audio and video.

HTML program is written using various tags and

attributes. These tags work together to produce the

desired result.

6. Explain the steps involved in creating an HTML

document.

A. To create an HTML page you need an editor or word

processor e.g. Notepad and a browser to run the page.

Open the Notepad, follow the steps
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Step 1 : Click the start button.

Step 2 : Click All programs.

Step 3 : Click accessories and select notepad. Type the

HTML document as shown beside.

Step 4 : To save the notepad file, click file menu, select

the save as option.

Step 5 : Choose the location, where you want to save

the file.

Step 6 : Type the file name with an extension .htm or

.html in the file name text box.

7. Briefly explain how to edit an HTML document.

A. To modify and incorporate changes in an HTML

document, follow the steps given below.

1. Search and locate the desired file in the Windows

Explorer.

2. Right-click on the icon of the file.

3. Move the mouse pointer on the Open with option.

4. A sub-menu will appear. Click and select Notepad from

it

To modify the code of your HTML document, Click on

the View menu of browser and select source. Close the

notepad window and click on the Refresh button on

Browser toolbar. Internet explorer will display the

modified page.

II. Fill in the blanks.

1. Hypertext Markup Language

2. Head and body
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3. container tags and empty tags

4. Bg color

5. Head tag

9. Formatting Tags

I. Answer the following Questions.

1. What is Formatting tag?

Formatting tags are some special tags, which do the

work other than the basic tags. These make the web

pages appear to be good looking. The formatting tags

can use at any place with in the body block and scripting

block of HTML

2. Write short note on

Comment tag:This tag allows you to include messages,

or "comments" within your HTML document, without

displaying those messages in the web browser.

Break tag:The BR and HR elements are empty elements.

The break <BR> tag is used to add line breaks that are

needed as in the case of addresses.

Horizontal rule tag: This tag is used to insert a horizontal

line with the specified thickness. The attributes that can

be used with the <HR> tag

Paragraph tag:The basic text formatting tag is the

paragraph tag denoted as <p>. It is a singular tag so

that <p> does not need a closing tag.

Preformatted tag: This tag is called the preformatted

tag <PRE>. The browsers will ignore excess blank
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spaces and indents in general. The <PRE> tag indicates

the enclosed text should be displayed in the fashion that

it has been entered.

3. Explain I brief about HTML headings.

A. A heading element implies all the font changes,

paragraph breaks before and after and any white space

necessary to render the heading. The heading tag is used

to define different heading levels in an HTML

document. There are six levels of headings starting from

<h1>...</h1> to <h6>...</h6>. H1 defines the most

important heading and uses the largest font among the

six heading tags. H6 defines the least important heading

4. Explain about B,I,U elements.

Z B Element

The text enclosed in the <B> tag appears in the bold

face. It is a container tag.

Z U Element

The text enclosed within the underline <U> tag

underlines the text. It is a container tag.

Z I Element

The text enclosed within this tag is displayed in an italic

type face. It is also a container element.

II. Fill in the blanks.

1. <I> or I element 4. <PPE>

2. <U> or U element 5. comment

3. <address>
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10. Lists and links in HTML

I. Answer the following Questions.

1. What is the difference between plain text and link ?

A. The difference between a plain text and a link is that

when the mouse is taken near a link the mouse pointer

will change to Hand symbol indicating that it was a link.

For a link you can observe an underline is placed

automatically.

2. How many types of list are there? Define them ?

A. ordered list

In ordered list the item were preceded by numbers

(1,2,3…), roman numbers (i,ii,iii,..) or alphabets

(a,b,c..). These lists are enclosed between the <OL>and

the </OL> tags.

Un ordered list

HTML Unordered List or Bulleted List displays

elements in bulleted format. Wecan use unordered list

where we do not need to display items in any particular

order.

3. How can you link web pages ? Write the Syntax ?

A The HTML anchor tag defines a hyperlink that links

one page to another page. It can create hyperlink to other

web pages as well as files, location, or any URL. The

"href" attribute is the most important attribute of the

HTML a tag. and which links to destination page or

URL.
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The syntax of HTML anchor tag is given below.

(<A>….</A>) is used to link the pages by specifying

the path of the next page to be viewed.

Syntax 1 : <A HREF= File Path > Display Name </A>

Syntax 2 : <A NAME= Text >

4. What are the attributes in ordered list ?

A. Ordered list has two attributes they are

Z Type

Z Start

Type Attribute

The "type" specifies to which it belong weather it is

roman, number or alphabet.<OL> tag has a type

attribute, which is used to change numbers to letters or

to roman numerals.

Start attribute

Start attribute in <OL> tag is used to select the starting

number of the list. So as it start the list from given

number

5. Explain about marquee tag.

A. You might have seen on most of the web site pages

scrolling the text. You can also observe on television

screen advertisements scrolling down. Such type of

effects can also be added to your pages using

<MARQUEE> tag. To use this tag enclose the text

between <Marquee> and </Marquee>.

6. What do you know about Anchor tag ?
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A. The HTML anchor tag defines a hyperlink that links

one page to another page. It can create hyperlink to other

web pages as well as files, location, or any URL.s

II. Fill in the Blanks

1. hand symbol 4. Data term

2. anchor tag 5. Bullets

3. "I"

11. Tables and frames in HTML

I. Answer the following Questions.

1. What is a Table? What are the attributes in it?

A. HTML table tag is used to display data in tabular form

(row * column). There can be many columns in a row.

Attributes in tables are alignments, borders, cell spacing,

cell padding and width.

2. What is a frame? What are the attributes in it?

A. In order to view multiple pages at a time HTML provides

a tag called <FRAMESET>. Using Frames you can

display different HTML documents at the same time.

The different parts that the screen is divided into are

called as frames. The attributes in frames are Color Tag

and  Image Tag

3. What are the Sub tags in Table tag?

A.

Tag Description

<table> It defines a table.

<tr> It defines a row in a table.
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<th> It defines a header cell in a table.

<td> It defines a cell in a table.

<caption> It defines the table caption.

<colgroup> It specifies a group of one or more

columns in a table for formatting.

<col> It is used with <colgroup> element to

specify column properties for each column.

<tbody> It is used to group the body content in a

table.

<thead> It is used to group the header content in a

table.

<tfooter> It is used to group the footer content in a

table.

4. Define Cell Padding and Cell Spacing.

A. Cell spacing

Indicates the amount space, in pixels, between each cell.

Must be part of a table cell element. Used with the

<TABLE> tag.

Cell padding

Indicates the amount of space, in pixels, between cell

borders and its contents. Must be part of a table cell

element. Used with the <TABLE> tag.

II. Fill in the Blanks.

1. rows and columns 3. <TR>

2. Frames 4. <FRAMESET>
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